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When you contact us for help, we'll need to know which version of the RAMM 
software you are using. 

TIP: Problems are sometimes fixed by simply upgrading your software to a 
later build. To find out which problems have been fixed in later builds 
than the one you're using, see our website Upgrades page 
(http://www.cjntech.co.nz/upgrades.htm). If you're running RAMM for 
UNIX, you may also need to upgrade your version of UNIX at the same 
time. If you have any questions about upgrading, feel free to contact us 
(see "Contacting CJN Technologies Ltd" on page 19). 

4 To Find the Software Build Number 

Go to the menu at the top of the RAMM main window, then choose Help > About. A 
small window shows details about the software. You'll find the Build Number at 
the top - in the image below it is 8.0005. 
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Forward Work Programming in RAMM was originally funded by Transit New 
Zealand. This guide has been reproduced with their kind permission. 

This guide is specifically intended to help you use and understand the functions of 
the Forward Work Programme module in the RAMM software from CJN 
Technologies. 

You may also need to refer the Using RAMM Guide. If you're not sure whether 
you're reading the right guide, see RAMM Guides (on page 17). 

This section tells you how to get the most out of using the rest of the document- if 
you're familiar with Forward Work Planning you can use the links to go directly to 
the section you need. If you're new to Forward Work Planning, we recommend 
that you read the entire guide. 

 

About This Guide 
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This section describes the many ways you can get help when you have problems or 
questions about using our software. 

IN  THIS  CHAPTER 
Finding the Answers You Need Quickly....................................14 
What You Should Already Know ................................................15 
Conventions We Have Used.......................................................15 
Help Yourself ..............................................................................16 
Help from Other Users ..............................................................17 
Help from CJN Technologies ....................................................17 
RAMM Guides............................................................................17 
RAMM Database Details ............................................................18 
Comments and Suggestions........................................................19 
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Finding the Answers You Need Quickly 

To Find Out How to Use Help 
For descriptions of the different types of help we have, formatting conventions 
and contact information - that's right here in the section you're reading now. 

To Find Out How to Work with a Particular Function 
Go directly to the section about that particular function - refer to the Contents. 

Answers Elsewhere 
If the task is not listed in the Contents, you may find it in another of the RAMM 
Guides. Check our list of RAMM Guides (on page 17) to make sure you've got the 
right one. 

To Find Out what a Particular Term Means 
Read the Glossary at the end of this Guide. 

To Find where a Particular Term Appears in this Guide 
Read the Index at the end of this Guide. 

Talk to Us 
Feel free to contact us (see "Contacting CJN Technologies Ltd" on page 19) 
directly. 
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What You Should Already Know 

The Microsoft Windows Environment 
Before you read this guide, you need to be comfortable working with the 
Windows environment and its applications. We assume you already know how to 
use standard Microsoft Windows applications. For more information about using 
Windows applications, please refer to the Windows user documentation - 
including the online Help which you can open by clicking on a blank part of your 
Windows desktop, then pressing the F1 key at the top of your keyboard. 

Security and Passwords 
Safeguarding passwords and security information is important. It's best never to 
write down a password, but if you must, keep it under lock and key. 

Data Backup 
Back up your data regularly. At the very least, you should back up your database in 
a location other than the computer you usually work on. Ideally, your entire 
computer's hard disk will be mirrored in another location such as a server or a 
network drive. Another cost-effective and secure backup solution is to use the 
RAMM Hosting Service. For more information, see our website 
(http://www.cjntech.co.nz). 
 

Conventions We Have Used 
This document uses certain ways of formatting text to identify special information.  

Formatting Convention Type of Information 
 (printed document) or 

Brown heading (online/web) 
Step-by-step procedures. Follow these instructions 
to complete a specific task. 

Bold Items you must select, such as buttons, menu 
options or items in a list. Menu options are 
separated by the > symbol. For example: View > 
Refresh. 

KEYS Keys on the keyboard. For example: SHIFT or 
CTRL. 

KEY+KEY Key combinations where you must hold down one 
key while you press another. For example: 
CTRL+P, or ALT+F4.  
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[Implied] Field Name Part of a field name not actually shown on the 
screen. 

> Menu Path > [Variable] A menu option that can have several values - usually 
Asset Types. 

Throughout this guide, when we refer to RAMM or a related application like 
RAMM Asset Valuation, RAMM Assessment, SLIM, Signs, or RAMM Traffic Signals 
we mean the Windows versions of our software. 
 

Help Yourself 
You can help yourself with integrated help, your printed help guide, or with web help. 

Many people like to be able to find their own answers. It's often quicker than other 
ways, and it's usually more satisfying. If you can't find the answer quickly, don't 
hesitate to ask us for help directly (see "Contacting CJN Technologies Ltd" on 
page 19). 

Using Integrated Help 
Press F1 on your keyboard in any window to access context sensitive help 

-OR- 

Click on the Help menu at the top of the window you're in and choose a relevant 
topic 

-OR- 

If you choose any of the Help > CJN Website options, your browser will be activated 
and take you to a page on our website (see Using Web Help below). 

Using the Printed Help Guide 
Printed help is useful especially when you don't have access to a computer. 

Using Web Help 
Our website (http://www.cjntech.co.nz) has number of resources that you'll find 
useful. Our Support page (http://www.cjntech.co.nz/support/index.htm) has links 
to documentation, reference, training and troubleshooting pages. If you're using an 
installed version of the application you can also download the latest version of the 
software from our website Upgrades page 
(http://www.cjntech.co.nz/upgrades.htm). 
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Help from Other Users 

Contacting Other Users 
When you have a problem or question about different ways of doing something, or 
you'd like to share ideas with those who have hands-on experience, you can ask 
other users. We'll be happy to put you in touch with them - just contact us (see 
"Contacting CJN Technologies Ltd" on page 19). 

CJN Forum 
You can also ask questions and participate in ongoing discussions in the CJN 
Forum (http://forums.cjntech.co.nz). 
 

Help from CJN Technologies 
We pride ourselves on our friendly, responsive support. If you need a helping 
hand, feel free to contact us (see "Contacting CJN Technologies Ltd" on page 19). 
 

RAMM Guides 
We publish a number of guides. Here's a brief overview of them and what they 
cover. 

With every major release of RAMM, we publish a brief description of what's new 
in the release: 

§ What's New in RAMM. 

Main functions and basic tasks in RAMM are described in: 

§ Using RAMM. 

Advanced functions in RAMM are in a separate guide: 

§ Working with RAMM, including: 

§ RAMM Network Manager. 

§ Transaction Logging. 

§ Surfaces. 
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§ RAMM SQL. 

§ Bridges. 

§ Maintenance Activity. 

§ Pavement Structure. 

§ Pavement Strength. 

§ RAMM Security. 

We have some other specific RAMM guides: 

§ Managing RAMM. 

§ Street Light Inventory Management (SLIM). 

§ RAMM Asset Valuation. 

§ RAMM Assessment. 

§ RAMM Forward Work Planning. 

§ RAMM Traffic Signals. 

We have two reference guides for advanced database details: 

§ Working with Treatment Lengths. 

§ RAMM Database Reference. 
 

RAMM Database Details 
Occasionally you'll need to know where specific details are stored in the RAMM 
database for more complex tasks. There are a number of ways to find out which 
tables and columns contain the information you need: 

§ Read the separate RAMM Database Reference guide. 

§ For the most up-to-date listing of the details you require, go to the RAMM 
Manager main menu and choose Reports > Database Structure. Choose the tables 
you wish to view and then Preview or Print them. 

§ For a general overview, read Understanding RAMM Toolbar Controls in the Using 
RAMM Guide. 

§ Ask workmates and associates who have used RAMM for longer. 

§ Contact CJN (see "Contacting CJN Technologies Ltd" on page 19). 
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Comments and Suggestions 
If you have any feedback about this document or about the software itself, please 
contact us (see below). We welcome your observations and suggestions, as they 
help us to improve what we offer you. 
 

Contacting CJN Technologies Ltd 
Web 
www.cjntech.co.nz 

Email 
support@cjntech.co.nz 

Phone 
+ 64 9 415 4790 

0800 CJNTECH (256 8324) within New Zealand only 

Fax 
+ 64 9 415 4791 

Post 
PO Box 302-278 
North Harbour 
Auckland 1330 
New Zealand 

Address 
12 Piermark Drive 
North Harbour 
Auckland 1311 
New Zealand 
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Transit New Zealand retains control of their RAMM master databases. They 
provide, to their Consultants, extracts of the database that are divided by 
Carriageway Area, referred to by Transit New Zealand as a Network Management 
Area. 

Your use of the RAMM Forward Work Programme and its facilities varies, 
depending on whether you are at Transit New Zealand and wish to work with the 
master database, or you are a Consultant and wish to work with a Network 
Management Area extract. 

For this reason throughout this document we refer to Nationally and Locally controlled 
information. Nationally controlled data and functionality means that it is available 
to Transit New Zealand. Locally controlled data and functionality is available to 
the Consultant. 

The type of database you have is determined by a flag, held within the database, 
that tells the RAMM Forward Work Programme whether you are working with a 
Road Controlling Authority (RCA) master database or a Consultant copy. 

If you are using the RAMM Forward Work Programme in a Local Authority 
situation you have two choices. You can either operate in a similar fashion to 
Transit New Zealand, working with the master database and generating one or 
more Consultant copies of the database to pass on. Alternatively you can operate 
with a single copy of the database that the RAMM Forward Work Programme 
recognises as being for a Local Authority and which allows access to both the RCA 
and Consultant data and functionality. This is achieved by setting the flag to Local 
Authority. Local Authority users can access all the functions described, whether 
national or local. 

While using this document, please keep in mind the type of environment you're 
working in (see "Forward Work Planning Environments" on page 179). 

 

Introduction 
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High Level Processes...................................................................25 
 

 

This guide is an introduction to the RAMM Forward Work Planning tool, and is 
written from the perspective of  Transit New Zealand (see Transit New Zealand - 
http://www.transit.govt.nz) and their Consultants. 

The RAMM Forward Work Programme is designed to store pavement treatment 
information at project level for a period of up to 20 years. 

For example, you could plan to carry out a grade 3/5 two coat reseal on SH 3 RS 
269 RP 0.100 - 2.540 in six years' time. 
 

Theory 
This document is to be used in conjunction with the State Highway Asset 
Management Manual (SHAMM, SM020). The SHAMM contains Transit New 
Zealand's philosophies and expectations for the management of State Highway 
Assets. 

The manual is also available online 
(http://www.transit.govt.nz/technical_information/content_files/ManualSection13
_FileName.pdf) at the Transit New Zealand website in Adobe Acrobat PDF 
format. 
 

Overview 
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Objective 
The primary purpose of this document is to help Asset Engineers use the RAMM 
Forward Work Planning software to meet the expectations of Transit New 
Zealand as described in the SHAMM. 

However Road Controlling Authorities will also find Forward Work Planning 
useful for effective road asset management. 
 

Overview Process 
Below is an overview of the process for development of a robust Forward Work 
Programme (FWP): 

1 Read SHAMM 

2 Manage Treatment Lengths 

3 Update Treatments 

4 Update Maintenance Intervention Strategy (MIS) codes 

5 Perform FWP Analysis and Reporting 

6 Review steps 1 to 4 as necessary. 
 

Lookup Codes 
In addition to the above, the Forward Work Programme also requires the 
management and maintenance of several lookup codes, these being: 

§ Funding Groups 

§ Treatment Groups 

§ Cost Sets 

§ Reasons 

§ Primary Motivators 

§ MIS Codes 
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As with all software applications, it's essential for these lookup codes to be initially 
populated to various degrees before preparing a Forward Work Programme. 
 

High Level Processes 
This document also describes a number of processes that will not involve the Asset 
Engineer but will nevertheless be useful. 

§ Unloading and Loading the Forward Work Programme 

§ Maintenance Allocation Review Group (MARG) Priority Calculation 

§ End of Year Rollovers 

 





 

  

C H A P T E R  5  

A detailed discussion of the reasons behind Forward Work Planning and the 
processes you should follow both within and external to its implementation in 
RAMM can be found in the SHAMM 
(http://www.transit.govt.nz/technical_information/content_files/ManualSection13
_FileName.pdf). 

IN  THIS  CHAPTER 
Philosophy of Pavement Maintenance Management .................27 
Business Systems Process Overview...........................................28 
Information Requirements .........................................................28 
The Intellectual Process ..............................................................29 

 
 

Philosophy of Pavement Maintenance Management 
Typically, Transit New Zealand allocates 56% of its annual budget for general 
maintenance, reseal, and pavement reconstruction works. This is required to 
maintain an acceptable level of service and to counter the normal deterioration 
rate. 

The amount of expenditure on maintenance works is significant and any small 
improvement in the way the network is maintained, without detriment to the long 
term integrity of the pavement, can lead to significant cost savings. 

Please see Chapter 1 - Section 1 of the SHAMM for a detailed discussion of the 
philosophy of pavement maintenance management. 
 

Understanding Forward Work 
Planning 
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Business Systems Process Overview 
Please see Chapter 1 - Section 2 of the SHAMM for an overview of the business 
systems designed to achieve coordinated and systematic pavement maintenance 
management at the project level. 

The adoption of standardised business systems is important to ensure consistency 
of output across the network. The business systems establish a uniform framework 
without constraining the input of suppliers in developing maintenance strategies. 

This section of the SHAMM covers Investment Levels, the Management Cycle, 
the Roles of Participants, and Business Practices. 
 

Information Requirements 
The key to successful asset maintenance management is the collection of 
sufficient, reliable data about the asset, collating this data into information, and 
interpreting this information to obtain intelligence. To be valid and appropriate 
the data must be: 

§ Relevant to the management decisions being made. 

§ Affordable and cost-effective so that regular collection and updating can be 
sustained. 

§ Reliable and adequately accurate for the intended purpose. 

§ Readily accessible and in a format suitable for those who need to manage and 
evaluate maintenance practices. 

Chapter 1 - Section 7 of the SHAMM discusses this in detail,  covering the following 
topics: 

§ Use of Data in the Management Process. 

§ Maintenance Costs. 

§ Crash Data. 

§ Traffic Data. 

§ Pavement Condition. 

§ Pavement Strength. 

§ Skidding Resistance. 
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§ Road Geometry. 

§ Environmental Factors. 

§ Future Developments on Data Collection. 

§ RAMM Inventory Data and RAMM Outputs. 

§ Presentation of a Multi-Year Works Programme. 

§ Trends and Exceptions. 
 

The Intellectual Process 
The intellectual process describes the process of applying intelligence to decision 
support information in order to determine future treatments. 

The process includes: 

§ The collation and interpretation of all available data. 

§ The application of intelligent decision support systems. 

§ Field verification. 

§ Consideration of all resulting information to resolve the application of the 
right treatments at the right time in compiling the Forward Work Programme. 

See Chapter 1 – Section 8 of the SHAMM which covers the following topics in 
more detail: 

§ The Process. 

§ Collation and Interpretation of Data. 

§ Intelligent Decision Support Systems. 

§ Field Assessment and Verification. 

§ Programme Preparation. 
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Initial Selection 
The initial assessment of Treatment Length should be based on the top surface 
layer and the changes in chip type or other surfacing treatment. 
 

Refinement 
When it becomes obvious that a seal length is not performing in a uniform 
manner, the Treatment Length shall be redefined to restore uniformity within the 
Treatment Length. Some maintenance treatments may extend beyond a single 
Treatment Length and provide a greater length of uniformly performing 
pavement. Treatment Lengths should be extended or deleted under such 
circumstances. See Maintaining the Programme (on page 37) for more 
information. 
 

Treatment Length Segmentation 
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Prerequisites for Generation 
Before generating Treatment Lengths, the RAMM database must contain: 

§  A Treatment Group that includes a check for all reseals. 

§ At least one Treatment which you're happy to set as the Birthday Seal for all 
generated Treatment Lengths. 

§ At least one Reason which you are happy to set as the default Reason for the 
Birthday Seal. 

§ For the chosen Reason, select one Primary Motivator from those available to 
use as the default Primary Motivator for the Birthday Seal. 

If you do not choose to Generate Birthday Seals, the Treatment Length 
Generation process will not create a Forward Work Programme for you. 
 

Generating Treatment Lengths 
In order to make use of the RAMM Forward Work Planning tool you need to have 
defined Treatment Lengths for your network. Whilst a full discussion of 
Treatment Length generation is outside the scope of this document it is useful to 
know the basics in order to create Treatment Lengths from the Top Surface data. 

Access to the Treatment Length Generation process is in RAMM Manager from 
the Processes > Treatment Lengths > Generate menu. 
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As indicated in the previous sections your Treatment Lengths should be generated 
based on the Top Surface information rather than from Carriageways. However, 
Forward Work Planning will work with the Treatment Lengths whichever method 
you choose. If you choose to generate from Top Surface data then you can also 
choose to ignore seal records if they are too narrow or too short and have RAMM 
"stretch" other seals to make them join. 

Finally, you can also have RAMM create a default Forward Work Programme for 
you as it creates Treatment Lengths. If you choose the option to "Generate 
Birthday Seals", RAMM will set up a Current Programme for you and place into it 
the Treatment, Reason, and Primary Motivator that you indicate apply to the 
Birthday Seal. The Planning Year in which the Birthday Seal takes place is 
determined from the Age and the Expected Life of the surfaces. 
 

Disabled Treatment Lengths 
As a consequence of the way RAMM generates Treatment Lengths there are often 
cases where one Treatment Length is actually a duplicate of another one. This 
situation most commonly arises when you have common State Highways or 
Intersections. Alternatively, there may simply be a section of road that you don't 
want to do any Forward Work Planning on, possibly because of its material (for 
example cobblestones). 

Using the Treatment Length Maintenance window available in RAMM (click on 
the Maintain Displacements button on the Treatment Length Grid/Detail window) you 
can set any Treatment Length to be disabled. 
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Disabled Treatment Lengths can be viewed and are kept up to date by Treatment 
Length Summarise, but are not available in the Forward Work Programme. By 
default a filter is set for the Treatment Length Grid/Detail to remove Disabled 
Treatment Lengths. Switch the filter off and you will see something like this: 

 

The two Treatment Lengths highlighted in red are those that are disabled. 
 

Status Check Flags 
Following any change to the start or end location of Treatment Lengths, the status 
flag of the road name is set to "changed". This implies that summary data is now 
invalid. Summary data held against the Treatment Length includes a summary of 
all rating and condition data, traffic data etc. 

To correct this status, run the Treatment Length Summarise process. You can 
access this process from the Processes > Status Check option in RAMM Manager. 
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Open the Treatment Length Tasks and select the Summarise Treatment Length 
data option. To run the process, click the Begin Processing button. 

This displays the following options dialog: 

 

Unless, you have reason to do so, don't change the defaults on this window. Click 
the OK button to begin the summarise process. 
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RAMM Forward Work Planning requires that there be at least one Forward Work 
Programme defined for your database. This programme will have a Format of 
Current Programme. The Current Programme is the one defined as the one that 
you are using in the field. 

You can create as many Alternative Scenarios as you require by taking a copy of 
either the Current Programme or one of your other definitions. However, only 
one Programme can be Current in your database. 

At any time you can select one of your Alternative Scenarios and set it to be the 
Current Programme. It will then replace your original Current Programme. Any 
Alternative Scenario that was generated by loading an Analysis from dTIMS 
cannot be set as the Current Programme. dTIMS Analyses do not use Forward 
Work Planning Treatments and are not specific enough to be used as the Current 
Programme. 

All programmes in the Forward Work Plan that are derived from dTIMS Analyses 
will be given a Format of dTIMS Recommendation. These Programmes are available 
to be used for comparison and reporting but cannot be used as the Current 
Programme. 

IN  THIS  CHAPTER 
Maintaining Treatments in the Programme...............................37 
The Planning Grid ......................................................................39 
Using the Planning Window.......................................................49 
Treatment Length Notes ............................................................58 
Programme Status Flags..............................................................59 

 
 

Maintaining Treatments in the Programme 
Maintaining Treatments in the Forward Work Programme involves the review of 
Treatments attached to each of the twenty-year planning periods for each 

Maintaining the Programme 
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Treatment Length. This also affects the attachment of Reasons, MIS, SIS, Notes 
and Priorities. 
 

Operation 
There are two methods for maintaining the Programme. Both are available in 
RAMM. You can access the information from the Treatment Length Grid by clicking 
on the Forward Work button. This method gives you access to the Planning window. 
Alternatively you can access the Planning Grid from the menu Forward Work > Planning Grid 

or by clicking on the Forward Work Programme Planning Grid icon  on the toolbar. 
 

Maintenance Rules 
§ The default blank cell attached to any of the twenty years for a Treatment 

Length signifies routine maintenance. 

§ All treatments must have a reason assigned. 

§ All Treatment Lengths must have a Maintenance Intervention Strategy assigned. 

§ Any change to treatments assigned to Years 1, 2 or 3 will default the MIS to 
blank. A new MIS must be attached before the change can be saved. 
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The Planning Grid 
The Forward Work Planning Grid is an environment much like Microsoft Excel, 
which allows you to maintain the Forward Work Programme. Access to the 

Planning Grid is via the Forward Work Programme Planning Grid icon  on the 
main RAMM Toolbar or from the menu Forward work > Planning Grid.  

Unlike the Planning Screen the Grid is linked directly to the Road Selection panel. 
Therefore, when you open the Planning Grid you will see the Forward Work 
Programme that applies for the portion of the network currently selected in the 
Road Selection panel. 

 

As you enter this window you will be in edit mode. As soon as you make any 
change the Save and Cancel buttons on the toolbar will activate. 

NOTE: To avoid losing a significant amount of work in the event of a system or 
hardware crash, it's recommended that you should save at frequent 
intervals. 

 

Selecting a Programme 
As a default, the Current Programme will be displayed on this window. However, 
you can select any scenario to work with by clicking on the Main Programme 
combo and choosing one from the list. 

The status message next to the Main Programme combo will tell you whether you 
are able to maintain the selected Programme. 
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Selecting an Alternative Scenario 
You can choose to display a second, alternative, Programme in the Planning Grid 
at the same time. To do this, first click on the Alternate button in the toolbar. 

This will display the Alternate Programme combo box for you to select the 
Programme you wish to see. 

 

You will notice that the Planning Grid displays the information from the Alternate 
Programme, row by row, underneath the Main Programme data. As you can also 
see this information is greyed out indicating that you cannot maintain it. 

The Alternate Programme is there to provide you with additional information. If 
you wish to maintain a Programme you need to select it as the Main Programme. 

A Forward Work Programme that has been loaded from a dTIMS Analysis can be 
displayed using the Alternate Programme. If the currently displayed Alternate was 
from dTIMS then the Analysis Date will be displayed next to the combo box. 

Remember that dTIMS data cannot be maintained using RAMM so you cannot 
select a dTIMS Recommendation as the Main Programme. 
 

The Planning Area 
The Planning Area of this window is divided into two areas, divided by a vertical 
bar. To the left of the bar is information that identifies the Treatment Lengths. 
That is the Road, Start and End Displacements and the Treatment Length Name. 
Of these, only the Treatment Length Name can be edited. 

To the right of the divider is the Forward Work Plan for the Treatment Length. 
This are is divided into three columns for each Planning Year. Up to 20 Planning 
Years can be displayed, however, you can use the Layout options to reduce that if 
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you require. To the left of the Planning Years are columns for the Cost Set, the 
Maintenance Intervention Strategy and the Safety Intervention Strategies. At the 
extreme right hand side of the Planning Years is one further column that holds the 
Treatment Length Notes. 

 

You have three choices when entering data in this Planning Grid. You can open up 
the expansion for each cell and select your Treatments, Reasons, etc. from the lists 
presented to you (a text area is displayed in the case of Notes). Alternatively you 
can type directly in the cell. The cell will accept a valid Treatment or Reason code 
along with the associated information such as Coverage or Primary Motivator. Be 
careful if you type directly in the cells. Strict formatting rules need to be followed, 
otherwise you will be presented with a series of error messages when RAMM 
assumes that you have entered invalid codes. 

Enter one or more Treatments by typing in the codes, separated by a comma and 
space. For example: BURN, DI, DM. If you wish to enter a Coverage or Priority, 
put them in brackets after the Treatment, separated by a comma. For example: 
BURN(50,H). If you do not enter the Coverage or Priority, RAMM will assume 
100% and Medium respectively. 

A similar structure is used for the Reasons and Primary Motivator. For example: 
BB(EF), BL(PP). 

Reason Notes can be typed directly in the cell or you can click on the expansion 
button (on the right of the cell) and a text box will open. 

Treatment Length Notes are more complex to deal with as they are associated with 
a length of Road that does not necessarily correspond to the Treatment Length. 
Therefore, the only way to enter a Treatment Length Note is via the expansion 
dialog (see "Treatment Length Notes" on page 58). The most recent note, 
applicable to the Treatment Length is displayed. For this reason, Treatment 
Length Notes are also excluded from the Copy/Paste functions detailed below. 

The third method for maintaining the Programme is to make use of the copy and 
paste functions to either copy information between cells or Treatment Lengths. 
You could also copy to Excel, maintain the information there, and copy it back in 
to the Planning Grid later. 
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Selecting a Treatment 
When you open the Treatment expansion you will see a list of all the Treatments 
that are valid for the Planning Year you are working with. 

 

Select one or more Treatments by clicking in the tick box. Coverage can be 
entered by clicking in the Coverage column next to the selected Treatment. 
Similarly, you can choose to set the Priority for the Treatment. 
 

Selecting a Reason 
Opening the Reason expansion displays a list of the Reasons that are associated 
with the Treatments. You can select one or more Reasons from the list by clicking 
on the tick box. 

 

Choose the Primary Motivator for your Reason by clicking in the Primary 
Motivator column next to the selected Reason. 
 

Reason Notes 
You can choose to type a Reason Note directly into the cell. If you prefer to work 
with a larger text area then click on the expansion icon that appears on the right of 
the cell when you click on it. 
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Treatment Length Notes 
Treatment Length Notes are displayed in the column at the right hand side of the 
Planning Grid. If you wish to see more details, then click on the expansion button 
that is visible when you click on the cell to display the Treatment Length Note 
(see "Treatment Length Notes" on page 58) dialog. 

 
 

Copy Functions 
You can use the Windows Clipboard and standard Copy and Paste functions to 
transfer information into the Planning Grid. Due to the complex way information 
is recorded for a Forward Work Programme and the relationships between the 
component parts, we advise caution. Here are some of the copy functions you can 
perform: 

§ Copy the Treatment, Reason, and Reason Note from one Planning Year and paste 
it into one or more others. 

§ Copy all the displayed information (everything to the right of the black bar in 
the image below) for a single Treatment Length and paste it into one or more 
other Treatment Lengths. 

§ Copy the highlighted row (or partial row) and paste it into a Microsoft Excel 
spreadsheet. 

§ Copy an entire Reference Station or Road ID and paste it into a Microsoft 
Excel spreadsheet. 

NOTE: To copy an entire Reference Station you need to click the Toggle multi-
select mode button and enable multi-select mode. See our example 
below. 

§ Copy the highlighted information from MS Excel and paste it into the 
highlighted row in the Planning Grid. 
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4 To Copy Planned Treatments, Reasons and Reason Notes from 
One Year to Another 

To copy the Planned Treatments, Reasons, and Reason Notes from a given Year 
simply click on any one of the three cells that make up that Planning Year and use 
the CTRL + C key combination. 

To paste this information into another Planning Year, you click on any one of the 
Cells within that Year and use the CTRL + V key combination to paste it in. 

The row will be highlighted in a colour as in the image below. 

 

4 To Copy and Paste a Row 

Copying and Pasting a row works in a similar way to that for a Planning Year. Click 
anywhere on the Treatment Length row that you wish to copy and press CTRL + 
C. 

Then click on the destination Treatment Length and press CTRL +V. 
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Copying To and Pasting From Excel 
You can copy to and paste information from Microsoft Excel in the Planning Grid 
using standard Windows Clipboard commands. 

To copy, first highlight all the cells that you require and press CTRL + C on your 
keyboard. Paste the information inside Excel in the normal way with CTRL + V. 

To paste information from MS Excel into the Forward Work Plan you simply 
highlight and copy the cells from Excel in the normal way. Click on the first cell 
(the topmost cell immediately to the right of the black line of the paste area) and press CTRL 
+ V. 

WARNING: Take care that you choose the correct starting position for your paste 
when bringing in data from Excel. The Planning Grid does not 
validate the information as you paste it in and will not care if you put 
Treatments in Reasons, or Reasons in Reason Notes, etc. It will, 
however, validate the data when you hit the Save button, resulting in a 
large number of errors if you haven't pasted the data correctly. 

4 Copying and Pasting To Microsoft Excel 

1 Select the Reference Station in the Road Selection panel. 

NOTE: To copy an entire Reference Station, click the Toggle Multi-Select Mode 
button to enable multi-select mode. 
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2 Highlight the information you want to copy and press CTRL + C. 

 

3 Open Microsoft Excel and press CTRL + V to paste the information into a 
file or cells of your choice. 

NOTE: To export the entire Reference Station as an Excel spreadsheet, click 
the Export File button  from the Grid toolbar, select Excel, and 
choose a file name and location to save to. 
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4 Copying and Pasting From Microsoft Excel 

1 In Microsoft Excel, highlight the section you want to paste back into the 
Forward Work Programme, and copy it to the Windows clipboard (CTRL + 
C). 

 

2 Carefully select the start point to paste the clipboard contents into the Forward 
Work Programme (for example, the cell indicated by the mouse arrow below) 
and press CTRL + V. 
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RAMM now pastes the data you copied in Excel at the selected point, and 
shows the new data highlighted in a different colour. 

 
 

Grid Toolbar 
The Planning Grid makes use of the standard Grid tool in RAMM. For more 
information on using the Grid toolbar please see the Using RAMM Manual. 

 
 

Validation Rules 
The rules for validation of Treatments, Reasons, Primary Motivators, and 
Maintenance Intervention Strategies are the same for the Planning Grid as they are 
for the Planning window (described below). 
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Using the Planning Window 
The Planning window allows you to access the Forward Work Programme for a 
preselected range of Treatment Lengths. 

To access this window, first open the Treatment Length Grid (or Detail) from the 
main RAMM Toolbar. 

 

Once you have selected which Treatment Lengths you wish to maintain click on 
the Forward Work button. This will then display the Planning window. 
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All the Treatment Lengths that are currently available in the Grid are maintainable 
from this window whether or not you have called it from the Treatment Length 
Grid or Detail. 

We look at the main part of the window in more detail in Planning Area (on page 
53) below. First, let's have a look at the contents of each of the tabs at the bottom 
of the window. 
 

General 

 

This tab allows you access to the general information about the Treatment Length 
and the Programme as it relates to that Treatment Length. 
 

Treatment Length 
The Treatment Length Group displays the Name, Displacements, and Cost Set 
that apply to the currently selected Treatment Length. You can change the Name 
of the Treatment Length or select a new Cost Set for it (from those available. 
However, you cannot maintain Treatment Length Displacements from this 
window. Treatment Length displacements can only be maintained by clicking on 
the Maintain Displacements button from the Treatment Length Grid or Detail. 
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Status 
The Status displayed on this window gives you information on where in the 
Planning Cycle the Treatments for this Treatment Length are. 

A Status of Please revise has come from the Review Process and indicates that 
Transit New Zealand would like the Consultant to look at this proposed work 
again and come up with a new recommendation. 

A Status of Ok indicates that the Planned Treatments for this Treatment Length 
have been reviewed by Transit New Zealand and approved. 

A Status of Proposed indicates that this is the recommendation for this Treatment 
Length, but that it has not yet been approved by Transit New Zealand. 

A Status of Changed indicates that the Consultant has made a change to the 
Treatments, Reasons, Primary Motivators, MIS, or SIS for this Treatment Length. 

A Status of dTIMS indicates that the Plan you are looking at has been loaded into a 
Forward Work Programme from a dTIMS Analysis. 
 

Notes 
This area of the window displays the Treatment Length level notes that are 
associated with the selected Forward Work Programme. 

See the section on Treatment Length Notes (on page 58) for more information. 
 

Review Notes 
Review Notes are entered by Transit New Zealand during the Review process. 
See the section on Reviewing the Forward Work Programme (on page 95) for 
more information. 
 

Intervention Strategies 
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All Treatment Lengths must have a Maintenance Intervention Strategy selected. 
Select one from those defined for the Network Management Area appropriate for 
the current Treatment Length. 

If you make any change to the Treatments in Years 1, 2 or 3, then RAMM will 
automatically remove the MIS associated with the Treatment Length. This is 
intended to ensure that you consider which strategy is most appropriate. You must 
select a new MIS for the Treatment Length before you can save the changes. 

See the section on Maintaining Maintenance Intervention Strategies (on page 64) 
for more information on adding and updating these codes. 

Other strategies are defined as Safety Intervention Strategy codes. You can choose 
one or more from the list of Safety Intervention Strategies. You are not required to 
choose one, so you may leave them deselected if you wish. 
 

Year 2 MARG Weightings 

 

This is one of the places where you can see and calculate MARG values for the 
Treatments in Year 2 of the Programme. 

See Project Ranking (on page 169) for more information. 
 



 

 C h a p t e r  7   –   M a i n t a i n i n g  t h e  P r o g r a m m e  5 3   

Planning Area 

 
 

Main Programme 
The Main Programme is the one that you wish to maintain. Typically this will be 
the Current Programme and the selection combo box will default to this one. Any 
Programmes that have been loaded into RAMM from dTIMS cannot be selected 
as the Main Programme. This is to ensure that you cannot edit the information 
loaded from dTIMS. Should you wish to view the dTIMS recommendation click 
on the Alternate button and select it there. 
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Main Programme Lock/Edit Status 
This field, which is next to the Main Programme combo, tells you whether you 
can edit the Main Programme that you selected. There are two pieces of 
information here. The first tells you if the Programme is Locked or not. The 
second says whether you have the authority to edit the Programme even if it is 
unlocked. 

A Programme may be locked because someone has made a decision to protect it 
from change. If the Programme has been unloaded it will also be locked to stop 
you from changing it until it is returned. 

Whether you can edit unlocked Programmes depends on what security 
permissions you have and on whether you are looking at the Programme in the 
Transit New Zealand main database or a Consultant's database for the Network 
Management Area. Transit New Zealand may not modify the Current 
Programme, although they may create a copy and edit it. 
 

Alternate Programme 
Click on the Alternate button to expand the Planning window in order to display an 
Alternative Scenario. 

The Alternative Programme is displayed for reference only. You cannot make any 
changes to this Programme. If you wish to update an Alternative Scenario you 
must select it as the Main Programme. 
 

dTIMS Analysis Date 
If you have chosen to display a Programme derived from dTIMS data loaded into 
Forward Work Planning, then this field will show you the date when the original 
dTIMS Analysis was carried out. This might have a bearing on the relevance of 
this data today. 
 

Main Programme Planning Year Cells 
There are cells in the Main Programme part of the window for each year of the 
20-year Planning Period. The first ten years are shown when the window is 
displayed. You can scroll to the right hand side to see the rest. The first year (on 
the left hand side) is considered to be Year 1, the current year. 

Each cell consists of two rows. The top row is used to display the code for those 
Treatments that you have selected for that year. You select Treatments by 
displaying the Treatment Toolbar (see "The Treatment Toolbar" on page 56) and 
ticking the ones that you require. Within the cell the codes are displayed separated 
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by a comma. If you have specified coverage for the Treatment, this is also 
displayed, in brackets, next to the Treatment code. You can choose as many 
Treatments as you require. Typically, this would be one or two. Display the 
Treatment Toolbar to clearly see which Treatments have been applied in that year. 

For each Treatment that you tick you also have the ability to define the coverage 
that you require and to indicate your estimate of the Priority that should be 
accorded to the Treatment. 

The second row of the Programme Cell is used to display the Reason and Primary 
Motivator for the Treatment(s). Once again the Reasons are displayed as codes 
with commas separating them. The Primary Motivator for a Reason is displayed in 
brackets next to the Reason to which it applies. Reasons are selected by displaying 
the Reason tab on the Treatment Toolbar and ticking the Reason(s) that you 
require. For each Reason you select you need to choose the Primary Motivator 
which best fits with the circumstances. 

In the Forward Work Planning window shown above you can see that some cells 
have a small icon next to the Reason. This indicates that a Reason Note has been 
entered for that Planning Year. These notes can only be seen by displaying the 
Treatment Toolbar. You can enter Reason Notes at any time. However, some 
Reasons require you to enter an explanatory note. 

If a cell is empty, that is you have not expressly assigned a Treatment to that Year, 
RAMM takes this to mean that Routine Maintenance will be taking place on that 
Treatment Length in that Year. 
 

Alternate Programme Planning Year Cells 
The Planning Years for the Alternate Programme are kept in alignment with those 
from the Main Programme. At no time can you edit the information displayed and 
this portion of the window is grey to indicate that it is read only. 
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The Treatment Toolbar 
Click on the Treatment button or double click on any treatment cell in the Twenty-
Year Programme to open the Treatment Toolbar. Once displayed this toolbar will 
remain visible and float above the other windows until closed. 

The toolbar will initially open up to be displayed as follows: 

 

If you want to see the Notes you can click on the Notes button. If you wish to see all 
the information at once, also click on the Expand button. 

 

The Treatment Toolbar keeps track of which cell on the Planning window you are 
currently in and displays the Treatments, Reasons, and Reason Notes that you 
have entered. Treatments and Reasons will be listed alphabetically unless they 
were already selected for the cell before you clicked on it. Pre-selected Treatments 
and Reasons will always appear at the top of the window. 
 

Programme Period 
All Treatments are assigned to a Programme Period. That is they are only available 
for entry into pre-defined years of the Forward Work Programme. The Treatment 
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Toolbar takes this into account. Treatments that are not available for the 
highlighted Planning Year do not appear on the Toolbar. 

The End of Year Rollover process advances all information from each Planning 
Year forward one year. This often causes a Treatment that was valid for one Year 
to be moved into a Year where it is not allowed. Forward Work Planning does not 
remove this Treatment, it is up to the Consultant to review the Plan and propose a 
valid alternative. Therefore, until it is removed, it will appear in the cell and on the 
Toolbar. 

Invalid Treatments that appear on the Treatment Toolbar can be unticked and 
ticked only so long as the Toolbar remains open and you do not move from the 
highlighted Planning Year. Once you untick the invalid Treatment and either 
close the Toolbar or move to work with another Planning Year, the invalid 
Treatment will disappear and you will not be able to add it again to that Year. 
 

Treatment Coverage and Priority 
On the Treatment tab of the Toolbar you can see two additional pieces of 
information that are displayed to the right of any selected Treatment. They are the 
Percentage Coverage and the Treatment Priority. 

As a default the Percentage Coverage is set to 100%. This indicates the Treatment 
you have selected is to be applied to the full length of the Treatment Length. If you 
do not wish to apply the Treatment to the full Treatment Length then you can 
enter a value here. 

The Treatment Priority can be used to indicate how important it is that the 
selected Treatment be carried out. This flag allows you to give your considered 
opinion independently of any automatic calculation of Treatment Priority, such as 
MARG. By default, the Priority is set to Medium, but you can change this to 
either High or Low. 
 

Reason Primary Motivator 
On the Reason tab of the Treatment Toolbar you can see an additional column of 
information for each of the selected Reasons. This is the Primary Motivator for 
the Reason. Not all Reasons require a Primary Motivator, but for those that do 
you will see a combo box here listing the Primary Motivators that are available to 
you. 

All Reasons that are assigned to Treatments in the first five Planning Years must have 
a Primary Motivator assigned to them (if they have been defined). 
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Treatment Length Notes 
Treatment Length Notes are accessible from both the Forward Work Planning 
window and Grid. They are intended as a way of associating general or review 
information with a length of the network rather than with a specific 
Treatment/Reason combination. 

Clicking on the Edit or New button in the Notes area on the Planning window 
displays the following dialog. A similar dialog is launched by clicking the  button 
in the Notes cell on the Planning Grid. 
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The reason for entering and maintaining these notes in a separate window is 
because they are associated with a length of the network. You can associate the 
note with any start and end displacement without recourse to the start and end of 
the Treatment Length. 

Multiple notes can be entered for a single Treatment Length. 

When displayed on the Planning window or grid, the notes will be visible against 
the Treatment Length they apply to. 

In addition to defining the Start and End Displacement for the note you need to 
select one of the Note Types that you have defined. 

Enter the note in the text box at the bottom of the window. The Added On and 
Added By information will be automatically populated for you. 

In addition you can choose to have this note available for all the Forward Work 
Programmes in your database by ticking the All Programmes check box. Should 
you either ignore or deliberately untick this tickbox then this note will only be 
displayed for the Programme you were working on when you entered it. 

Finally, you can also choose to have this note displayed prominently when you 
move onto the Treatment Length. Do this by clicking on the Bring-up tick box. 
 

Programme Status Flags 
Any change to the Treatments assigned to a Treatment Length, the reasons, MIS, 
or SIS will alter the status of the Treatment Length to Changed. This status change 
is used in the approval process of the programme. The following rules apply: 

§ A consultant does not have access to the Approve/Reject status change. 

§ Transit New Zealand staff have no access to change treatments (thus effecting 
a status change to Changed). 
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Maintenance works should normally be considered for implementation once the 
maintenance intervention level has been reached or exceeded. 

For a full discussion on the application of maintenance interventions, the highway 
environment, and intervention levels see Chapter 1 – Section 5 of the SHAMM. 

 

Maintenance Interventions 
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A Maintenance Intervention Strategy is a detailed statement of the type of 
maintenance activity that should be targeted to the Treatment Lengths identified 
in the Forward Work Programme.  It is the principle method of conveying the 
appropriate activities to all parties involved in the maintenance of an asset. 

Maintenance Intervention Strategies are designed to ensure the optimum use of 
maintenance funding by ensuring that routine activities are appropriate given the 
programmed treatments. 

A more detailed discussion of Maintenance Intervention Strategies, covering 
objectives, alignment with policy, and typical strategies is found in Chapter 1 – 
Section 6 of the SHAMM. 

IN  THIS  CHAPTER 
Maintenance Intervention Strategy Codes .................................63 
MIS Costs....................................................................................64 
Maintaining Maintenance Intervention Strategies .....................64 

 
 

Maintenance Intervention Strategy Codes 
Maintenance Intervention Strategies may vary between Network Management 
Areas. In some cases this difference may simply be using the same code for 
different descriptions (or vice versa). However, the maintenance of these codes is 
done nationally. Please contact Transit New Zealand to arrange for new codes to 
be added. These codes will then be delivered to Consultants via the National 
Table Export/Import (see "National Tables Export" on page 165). 
 

Maintenance Intervention 
Strategies 
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MIS Costs 
All Maintenance Intervention Strategies have costs associated with them. Even if 
the MIS Codes are common between the Network Management Areas, it is 
unlikely that the costs will be common. It is the responsibility of the Consultant, 
therefore, to define the MIS costs for their region. 
 

Maintaining Maintenance Intervention Strategies 
MIS Codes are maintained in RAMM Manager from the menu Projects > Forward 
Work > Maintenance Intervention Strategies. 
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Maintenance Intervention Strategy definitions are maintained nationally by 
Transit New Zealand. However, because there is a danger of codes having 
different meanings between Consultants, they are recorded separately by Network 
Management Area (NMA). 

When inserting a new MIS Code you first need to select the Network 
Management Area to which it is applicable. Within the NMA the Code that you 
use must be unique. However, it does not matter if you use the same code to 
mean different things in different NMAs. 

New and updated MIS definitions can be supplied to Consultants by using the 
National Table Export/Import. 

Transit New Zealand cannot update the Unit Cost / km for the MIS in each of the 
Cost Sets. This can only be done by a Consultant, using their copy of the database. 
This information will not be lost as it is included in the data transferred back to 
Transit New Zealand in the Forward Work Unload and Load processes. 

MIS can be used the year prior to or the year of a treatment as a special 
maintenance cost which overrides the routine maintenance cost interpolated from 
the Routine Maintenance Cost Estimation (RMCE) curve. They may have 
different values for each cost set. 

There are default MIS in the database, but the Consultant should develop their 
own and apply their own costs to these. They should also supply these MIS to 
Transit New Zealand so that the cost balancing can be run successfully. 
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See Chapter 2 – Sections 1 to 5 of the SHAMM for a discussion of the processes 
necessary to ensure the safety of the State Highway network.  The process is 
determined by the preparation, implementation, and review of the Safety 
Management Strategy. 

IN  THIS  CHAPTER 
Safety Intervention Strategies......................................................67 

 
 

Safety Intervention Strategies 
A Safety Intervention Strategy (SIS) forms part of the Safety Management 
Strategy. Chapter 2 – Section 6 of the SHAMM discusses the definition and purpose 
of a SIS, intervention levels, considerations, and a hazard register. 
 

Maintaining Safety Intervention Strategies 
Safety Intervention Strategies can be maintained in RAMM Manager from the 
menu Projects > Forward Work > Safety Intervention Strategies. 

 

SIS codes are defined and maintained nationally by Transit New Zealand. Codes 
are defined separately for the different Network Management Areas so that there is 

Safety Management Strategies 
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no clash between those used by the different Consultants. If you require a new 
code to be added then contact Transit New Zealand and they can add it for you. 

New and updated SIS codes can then be delivered to the Consultant using the 
National Table Export/Import (see "National Tables Export" on page 165). 

When inserting a new SIS code you will first have to select a Network 
Management Area. Within each area the SIS Code must be unique, but the same 
code can be used in different NMAs to mean the same or different things. 
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After an End of Year Rollover 
If you have just set up a Forward Work Programme or it is not the beginning of a 
new Financial Year and you have not run the End of Year Rollover process you can 
ignore the rest of this section and continue on. 

However, if you have just performed an End of Year Rollover or have received a 
new copy of the database following a Rollover you will need to check your 
Programme for Treatments and Primary Motivators which are no longer valid or 
missing. 

Fortunately, RAMM Forward Work Planning provides you with two Reports to 
help you. They are: 

§ Out of Date FWP Treatments Report. 

§ Missing Primary Motivators Report. 

See End of Year Rollover (on page 156) for a more complete discussion on this 
process. 
 

Out of Date FWP Treatments Report 
As detailed earlier, treatments are defined as being valid for given periods within 
the Forward Work Plan. When the End of Year Rollover takes place Treatments 
that were previously in Year 4 are now in Year 3. However, it may be that some of 
them are not valid for use in Year 3. 

RAMM Forward Work Planning provides you with a report to quickly allow you 
to find the Treatments are not valid for the Year in which they now find 
themselves. 

You can access this report in RAMM Manager from the menu Reports > Forward Work 
> Out of Date FWP Treatments. 
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Choose the Programme that you are concerned about (the Current Programme is 
displayed by default) and click on the Preview or Print button. 

 

Using the report you can find and correct those Treatments that are now out of 
date. 
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Missing Primary Motivators Report 
Many Treatment Reasons have one or more Primary Motivators associated with 
them. Whilst you do not need to assign a Primary Motivator to a Reason in Years 6 
to 20, you do need to assign one (where they are applicable) to the Reasons in 
Years 1 to 5. 

After the End of Year Rollover, the Treatments and Reasons from Year 6 will now 
be in Year 5. Therefore, RAMM Forward Work Planning provides you with a 
Report that allows you to quickly locate any Reasons that now need Primary 
Motivators.  

You can find this Report in RAMM Manager under the menu Reports > Forward Work 
> Missing Primary Motivators. 

 

Choose the Programme that you are concerned about (the Current Programme is 
displayed by default) and click on the Preview or Print button. 
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Using the report you can find and correct those Reasons where Primary 
Motivators are now required. 
 

Inactive Forward Work Programme Treatments 
Forward Work Programme Treatments are defined and maintained by Transit 
New Zealand. It may be that Transit New Zealand has decided that some of these 
Treatments are now Inactive. Therefore, when you receive a new Consultant copy 
of the database, it is a wise precaution to check your Forward Work Programme to 
see if you are applying any Treatments that are now Inactive. 

To help you a report is available in RAMM Manager from the menu Reports > 
Forward Work > Inactive FWP Treatments. 
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Select the Programme that you are interested in analysing (the dialog defaults to 
the Current Programme). Click on the Preview or Print button to see the results 
of the analysis. 

 

This is an example of a Forward Work Programme which still has Inactive 
Treatments assigned to Treatment Lengths within the Twenty-Year Programme. 
 

Trends and Exceptions 
The collation of data does not itself provide the means of identifying problem 
sites. 

The interpretation of the data is important, as this is the process which identifies 
the trends and exceptions essential for the early identification of faults and the 
subsequent selection of treatments for each Treatment Length. 

Chapter 1 - Section 7.13 of the SHAMM discussed the types of indicators, 
interventions, and customised indicators for trends and exceptions. 
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Exception Maintenance 

Overview 
You can use exceptions to search through Treatment Length summary data 
finding Treatment Lengths that are performing abnormally. Run this from the 
Projects > Forward Work > Exceptions menu from RAMM Manager.  

An exception can be based on either, a filter or an SQL query you have created. 
You can also start by using the filter tool to develop the exception and switch to 
SQL when more complex searches are required than the filter tool offers. 
However, once you switch to SQL you can no longer access the exception as a 
filter. 

When running an exception all Treatment Lengths matching the criteria you have 
specified are tagged with the code of that exception. These tags remain against the 
Treatment Length until you clear them or rerun the exception. 

To find all the Treatment Lengths tagged by an exception use RAMM. Click on 
the Treatment Length icon and filter the grid for Treatment Lengths with that 
exception code. 
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To create a new Exception definition you first need to insert a new record, 
selecting a Network Management Area, giving it a unique Exception Code, and a 
Description. You can also add some explanatory notes if you wish. 

Once you have your basic definition you need to add the selection criteria. Do this 
by clicking on the Edit Filters button. This will cause the following window to be 
displayed. 

 

Filtering information for Treatment Lengths is complex as a result of the diverse 
range of tables that hold Treatment Length related data. 

Therefore, you will need to choose what type of Treatment Length information 
you want to search for using the following window. 
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In this example we have chosen to search for information from the Treatment Length 
details and Latest summary data. This causes a Filter Dialog to be displayed as follows. 

 

Use this in the same way as you would for filtering any asset and select from the 
information available and define the search criteria. 

The following window shows some selection criteria based on the Surface Date 
and First Chip Size. 
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Once you have saved your definition you can look at the SQL that has been 
generated for you based on the selection criteria. The following is the SQL from 
the query described in the last window. 

 

As you can see, this SQL is quite complex. However, if you want to alter this SQL 
you can do so by clicking on the Edit button. If you do this you will be warned as 
follows: 

 

The reason for this warning is that RAMM will no longer be able to determine the 
component parts of your SQL once you have altered it. Therefore, once you have 
done this there is no going back and you will only be allowed to edit the SQL from 
now on. 

In edit mode the SQL window looks like this: 
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When you have finished altering the SQL click on Ok to save the changes. As you 
can see from the following example, you can only click on the View (Edit) SQL button 
from now on. 

 
 

Edit Filters 
This allows you to define a Treatment Length filter for the exception. 
 

View (Edit) SQL 
Shows the SQL used by RAMM to select Treatment Lengths matching your filter 
criteria. You may choose to Edit the SQL directly from this window however you 
will no longer be able to use the filter interface to modify the exception. Use the 
Edit option for complex queries that the filter mechanism cannot accommodate, 
for example introducing 'OR' into the query. 
 

Run Exception 
The exception must be saved before you can run it. The Run Exception button 
runs only the currently displayed exception. The exception code is cleared from all 
Treatment Lengths then reset by running the exception filter or SQL. Other 
exceptions are not affected. 
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File > Run Multiple Exceptions 
Use this option to run more than one Exception definition at once. 

 
 

Exception Reset 
Selecting this tickbox will force all exception codes to be cleared from Treatment 
Lengths regardless of whether you choose to run the exception from the Exception 
List box. This does not delete any of your exceptions, only the codes held against 
Treatment Lengths are cleared, the definition of the exception is unaffected (all 
exceptions defined in the Exception Maintenance window will remain). 
 

Exception List 
Choose the exceptions to run. Unless the exception reset tickbox is selected 
exception codes are only cleared for the exceptions you choose to run. 
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Using the Exception 
Once you have created and run the exception it will appear in the Treatment 
Length filter, which is very similar to the mechanism used to create the exception. 
The difference is that the Treatment Length filter provides searching by 
exceptions.  

To do this, select the filter type Exceptions. 

 

Note that the Exceptions Filter option is only available from the Treatment 
Length Filter in RAMM. 
 

Why Use Exceptions? 
§ Building an exception allows you to develop a search and tag all the Treatment 

Lengths matching the query at that time. You can then close RAMM for 
Windows and find exactly the same set of Treatment Lengths next time by 
searching for the exception. The list of Treatment Lengths found will remain 
the same until you re-run the exception. 

§ For complex queries it is much faster to filter for an exception you have already 
run, compared to re-running a complex filter. 

§ When necessary you can edit the Exception SQL directly. This is not available 
for a Treatment Length filter. 
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Forward Work Detail Report 
This is a detailed report of the Twenty-Year Programme for the Treatment 
Lengths within the selected Road. 

The report can be configured to look at either the Main Roads or the Ramps. 

It is possible to choose to report on the Current Forward Work Programme or one 
of the alternative scenarios. The report can be further configured to choose an 
Office or Local Area. 

You can access this report from within RAMM using the menu Forward work > Detail 
Report. 
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As you can see from the Options Dialog there are a number of variations of this 
report that you can choose from. 

Firstly, you can choose to report on the Main Roads or the Ramps Only. You can 
also select which of your Programmes that you want to send to the report. By 
default the Current Programme is selected. You can then choose to filter the 
report down to the Office or Local Area level. 

When Forward Work Planning was first implemented it was designed to support a 
10-year Forward Work Programme. It has since been extended to support a 20-
year Programme. However, for convenience and to save space, you can choose to 
look at only the first 10 years of the Forward Work Plan. 

This report will, by default, only show you the most recent note that applies to 
each Treatment Length. However, you can choose to have all notes displayed in 
the report. See the section on Treatment Length Notes (on page 58) for more 
information on using these notes. 

 

The example report shown here is for Main Roads, over 10 years of the Current 
Programme, and displays only the most recent notes. 
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Contractors' Programme Report 
The Contractors' Programme Report gives you details of the first five years of the 
Forward Work Plan. The format is similar to the Detail Report. 

Access to this report is in RAMM using the Forward work > Contractors Programme Report 
menu. 
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As you can see from the Options Dialog there are a number of variations of this 
report that you can choose from. 

Firstly, you can choose to report on the Main Roads or the Ramps Only. You can 
also select which of your Programmes that you want to send to the report. By 
default the Current Programme is selected. You can then choose to filter the 
report down to the Office or Local Area level. 

This report will, by default, only show you the most recent note that applies to 
each Treatment Length. However, you can choose to have all notes displayed in 
the report. See the section on Treatment Length Notes for more information on 
using these notes. 

 

The example shown here is for Main Roads and is reporting the first five years 
from the Current Programme. Only the most recent notes are displayed. 
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Field Inspection Report 
The Field Inspection Report contains all the information that you might need, 
from the Forward Work Programme for your Treatment Lengths, to take with you 
into the field when doing an assessment. 

You can choose to extract the data from one or two Programmes (for comparison). 

There are two versions of this report. One is in a fixed format and available to 
print or export to Microsoft Excel. The second is in the form of a Grid that you 
can manipulate in order to display those parts of the data that is of interest to you. 

Many people have their own version of the Field Inspection Report, which have 
been created using MS Excel. Therefore, to make life easier the new Grid Field 
Inspection Report in RAMM can be used to save the data you require directly in 
MS Excel format. You can then use this as the data source for your own report. All 
the data that you require should be available so this provides an easy route to 
getting the information. 
 

Formatted Version 
The formatted version of the Field Inspection Report is available in RAMM under 
the menu Forward work > Field Inspection Report > Formatted. 
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As you can see from the options dialog, above, you can choose one or two Forward 
Work Programmes to be sent to the report. Details from the Main Programme will 
appear above those from the Alternative in the report. By default the Main 
Programme is set to be the Current Programme, but you can change this if you 
wish. 

Along with your choice of Programmes you can also filter the report by the Region 
or Network Management Area. 

Among the information that is available on this report is the Treatment Selection 
Algorithm recommendation. Since it is possible to run a number of TSA Analyses 
during the course of your review of the network, RAMM needs to know which 
one to extract the data from. 

 

This example of the report is in A4 format and is for the Current Programme 
only. 
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Grid Version 
The grid version of the Field Inspection Report is available in RAMM from the 
Forward work > Field Inspection Report > Grid menu. 

 

This example of the Field Inspection Report Grid has been generated for the 
complete network as present in the database. 

You can choose to run the report for only a portion of the network by choosing 
from the Location options. You will also need to select a TSA Header from those 
available. Once you have made your choices click on the Generate button to 
populate the report grid. 
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Balancing the Programme 
This window is available in RAMM from the Forward work > Balancing menu. 
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This is a formally formatted report that is used for audit purposes when a 
Consultant returns the Forward Work Programme to Transit New Zealand. Use 
the radio buttons provided to select the filters to be applied (for example: status - 
ALL or Changed) 

Use the Office and Local Area fields to select the parts of the programme to be 
summarised for balancing. 

The Programme Summary reports the total dollars calculated from the appropriate cost 
sets for total (total programme) and available (the difference between target and 
total). To enter or edit targets select the Edit Targets push button. Enter a value for 
each of the twenty years against each network management area and sub-area. 

The Reseal Cycle Rate is calculated by dividing the total length of resealing 
programmed by the total length of the network. Where an Office and Local Area 
are selected, the lengths used are those relating to the selection. 

The Programme Detail window reports either dollars (in $000) or length (in km) for 
each of the Treatments, Treatment Groups, or Funding Groups as selected. The 
dollars and length are calculated on the basis of the treatments programmed, the 
length of the Treatment Lengths to which they apply, and the costs assigned 
through the treatment cost set. 

Any change to the treatments assigned to a Treatment Length, the Treatment 
Length itself, or the costs assigned through the cost set will invalidate the 
programme balancing data. The table is flagged as invalid, and before it can be 
viewed you need to recalculate the Programme Costs. 

A formatted report based on the information on this window is also available by 
clicking the Preview Report button or choosing the menu Actions > Preview Report. To 
print it, click the Print button or select Actions > Print. You can also generate an Overview 
Report (on page 92) graph. 
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Overview Report 
You can generate an Overview Report in graph format from the Forward Work 
Programme balancing window. 

Click the Overview Report button, or select Actions > Overview Report. 
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Editing Programme Targets 
This screen is available in RAMM from the Programme Balancing window by 
using the Actions > Edit Targets menu. 

 

Enter Target Values for the twenty Planning Years and those Sub-Areas that 
require them. All Targets for a given Planning Year are added together and 
displayed in the Programme Summary area of the Balancing window. 

 
 

Programme Outputs 

Format 
The programme includes the following information: 

§ Treatment Length referenced by route position. 

§ Treatment Length reference name. 

§ Date and type of last seal coat and expected life. 
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§ Upper pavement moisture sensitivity. 

§ Maintenance intervention strategy applicable for the Treatment Length. 

§ Treatments (other than reactive maintenance) against each of the 20 years. 

§ Comments. 
 

Programme Accuracy 
The first year of the programme is the current financial year and represents the 
work programme in progress. 

The second year represents a firm recommendation on works for which funds 
should be sought for treatment in the next financial year. 

The third year presents a reasonable assessment of the needs. There must be some 
tangible evidence supporting the programme for that year. 

Years 4 to 20 represent an intuitive assessment based on considerations including 
age and expected life. 
 

Pretreatment 
Pretreatment needs (for example: drainage works prior to resealing) shall be 
indicated in the programme. 
 

Economic Analysis 
Whenever possible the Year 1 and 2 programmes should be supported by 
economic analysis. This is a pre-requisite for pavement reconstruction, seal 
widening and improvement works which should have benefit/cost ratios above the 
current cut off ratio or otherwise have prior client funding approvals. 
 

Project Development Status 
Construction works shall have the current project development status (Point X or 
Y) as defined in the Transit New Zealand Land Transport Programme 
Development and Management Manual, confirmed in the comments section of 
the programme. 
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Reviewing the Forward Work Programme 
Once the Forward Work Programme has been completed by the Consultant it is 
ready to be reviewed at Transit New Zealand. This section details the process by 
which this takes place. 
 

Review 
The Twenty-Year Programme is subject to constant review. The adequacy of the 
proposed treatments may change as the pavement deteriorates. Other factors for 
example, crash statistics, may influence improvement works. 
 

Review Frequency 
Two formal reviews of the twenty-year programme are required. 

One review is required once the results of the RAMM Condition Rating Survey, 
Treatment Selection, and Roughness Survey have been completed and needs to be 
timed to coincide with NLTP development. This is generally carried out in 
October. Another review is required once the level of funding for the following 
year is confirmed. Programmes and strategies will need to be aligned to approve 
funding levels. This is generally carried out in May. 

Other reviews may be required whenever any funding changes occur or pavement 
deterioration does not occur as expected. 
 

Basis of the Review 
Whenever a formal review is undertaken all data inputs shall be updated. The 
following actions shall also be undertaken: 

§ Adjustments to the current work programme shall be made in accordance 
with physical works achievements. 

§ The programme for the following four years shall be reviewed in 
consideration of the best currently available information. 

§ Refinement of preventative maintenance or pretreatment programmes shall be 
provided in terms of extent and cost. 

§ Priorities shall be determined for works recommended in the following year. 
 



 

9 6  R A M M  F o r w a r d  W o r k  P r o g r a m m e  
 

Forward Works Programme Review Procedure 

Overview Of Transit New Zealand (RCA) and Consultant Roles In Review 
Process 

 
 

Permissions 
Consultant 
§ Can edit the Current Programme (provided it is not locked). 

§ Cannot change the Review Programme loaded from Transit New Zealand. 

§ Can copy Programmes to create Alternative Scenarios and then edit these. 
 

Transit New Zealand 
§ Cannot edit the Current Programme. 

§ Can add instructions to the Current Programme in the form of Review Notes, 
so that the Consultant can edit the Programme. 

§ Can also copy Programmes to create Scenarios and then edit the Scenarios. 
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Preparing to Review the Programme 
Reviewing a Forward Work Programme is the responsibility of staff at Transit 
New Zealand. However, some of the steps in this process need to be carried out 
by the Consultant who is maintaining that Programme. 

Therefore, this section describes all the steps taken by both Transit New Zealand 
and the Consultant when a Programme Review is being carried out. 
 

Maintaining Review Shortcuts 
Reviewing the Programme is a Transit New Zealand function that can only be 
carried out on the master database held by Transit New Zealand. Therefore, the 
ability to define and maintain the Shortcut Keys used in the Review process can 
only be done by Transit New Zealand. This window is available in RAMM 
Manager from the menu Projects > Forward Work > Review Shortcuts. 
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This window is used to define a Shortcut Key for a recommendation that you 
might use frequently during the course of a Review. 

Each Shortcut consists of a Description (the name of the Shortcut), a note that will 
be recorded in the Review Notes area, and a set of actions that will be carried out 
on the Treatment affected. 

The Review action comes in three parts: 

Treatment Displacement 
This moves the Treatment from its current Planning Year to one either before or 
after the current one. 

Status 
This action changes the Status of the Programme for the given Treatment Length. 

Priority 
This action changes the Priority associated with the Treatment to give an 
indication of how important it is to carry it out. 

To set the Shortcut Key you click on the Shortcut Key data field and then press 
your choice of keys on the keyboard. Your choice will be displayed in the data field 
and you confirm that it is to be used by clicking the Set Shortcut button. 
 

Treatment Displacement 
This moves the Treatment from its current Planning Year to one either before or 
after the current one. 
 

Status 
This action changes the Status of the Programme for the given Treatment Length. 
 

Priority 
This action changes the Priority associated with the Treatment to give an 
indication of how important it is to carry it out. 

To set the Shortcut Key you click on the Shortcut Key data field and then press 
your choice of keys on the keyboard. Your choice will be displayed in the data field 
and you confirm that it is to be used by clicking the Set Shortcut button. 
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Programme Balancing Report 
Transit New Zealand also requires a copy of the Balancing Report to accompany 
the Forward Work Programme files. Please see the section on Balancing the 
Programme (on page 89) for a description on how to produce this report. 
 

Starting the Programme Review 
Transit New Zealand has the ability to formally review the Current Forward Work 
Programme and either approve the proposed work for each Treatment Length or 
make recommendations for alterations. 

Transit New Zealand cannot make any changes to the Current Programme, and 
can only make recommendations that are passed back to the Consultant. 
 

Programme Review 
Programme Reviews can only be carried out by Transit New Zealand. The 
objective of this process is to acknowledge all proposed treatments as acceptable, or 
alternatively instruct the consultant on changes that are to be made. 

Instructions are issued in the form of review notes attached to Treatment Lengths 
in the current programme. The suggested changes (defer one year etc) are 
reflected in the review programme. The client can gauge the effects of the 
suggested changes by looking at the programme balance for the review 
programme. 
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Initiating a Review (Transit New Zealand) 
To begin the Review process you must first initiate the review for the Current 
Programme. You can do this in RAMM Manager from the Programme 
Maintenance window by choosing the menu Actions > Review > Initiate. Alternatively, if 
you are using the Planning window in RAMM you can initiate a review using the 
menu Actions > Initiate Review.  

The status of the Programme should be unlocked but not editable before the review is 
initiated, and this does not change. 

It is the Consultant's job to select the appropriate treatments, and thus Transit 
New Zealand cannot edit a current forward works programme; they can only 
review it, make comments on it and then return it to the Consultant for updating. 
Physical changes are made on the review copy of the programme. 

Once the review is initiated, the "Copy Programme for Review" window is 
opened.  

 

This window gives the choice to review some or all of the Network Management 
Areas contained in the programme, and whether to make a review copy of the 
current programme. This review copy can by viewed with the current programme 
in RAMM when the review is being performed (see below) so it is recommended 
that this copy be made. The copy has a status of editable by review only. 
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Reviewing the Programme 
When the Current Programme is in Review the Forward Work Planning window 
looks like this: 

 

The Review Mode, Shortcuts, and Bulk Review buttons are now available to you. 
 

Review Mode 
Allows you to begin reviewing the Current Forward Work Plan and opens the 
Review Shortcuts toolbar. 
 

Shortcuts - Reviewing the Programme 
Opens the Review Shortcuts toolbar if it has been closed. 
 

Bulk Review 
Opens the Bulk Review window to allow you to review more than one Treatment 
Length at one time. 
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Working in Review Mode 
To begin reviewing, press the Review Mode button on the toolbar. 

This opens the Review Shortcuts window and allows Transit New Zealand to add 
notes to the programme by selecting cells and then adding the desired instruction 
by clicking the appropriate button in the Shortcuts window. 
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Shortcuts 
The shortcut buttons are designed to attach clear instructions to the Consultant on 
what actions are required. Review notes detailing the instruction are automatically 
attached to the Treatment Length when the buttons are pushed. 

When "Please Revise" is added to a Treatment Length, there should also be a note 
accompanying this.  

 

This note can be added by entering it into the box in the Shortcuts window, then 
pressing the Add to notes button. This results in a note that looks like: 

 

This note will then be recorded as a Review Note for this Treatment Length. 
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Working With Alternative Programmes 
Pressing the Alternate Programme button will bring up the review copy of the current 
programme underneath the current programme (or any other programme when not 
in Review Mode). This is to allow two programmes to be compared, and allows 
the suggested changes to be physically made on the review copy. If the review copy is not 
open the suggested changes will not be made on it. 

 

This review copy shows the changes requested. The current programme is not 
changed - it only has instructions to the Consultant added in the review notes 
window. 
 

Working With Alternative Programmes (Example) 
If we choose to advance the 2005/06 Treatment by one Year we would see the 
following: 
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Working with the Bulk Review 
The Bulk Review button opens the Bulk Review window. 

 

This window lists all Treatment Lengths for a Network Management Area, and 
allows filtering of these Treatment Lengths. A number of treatments can be selected 
at once by holding down the CTRL key and picking cells, and then these can have the 
same instructions added concurrently. For example, a filter may be applied to 
show all low-priority Year 2 reseals, then after selecting them all the shortcut 
button to defer all of these by one year can be pressed. 

When viewed in the Bulk Review window, the programme is updated as changes 
are made (i.e. this view behaves the same as the Review copy in that it shows the 
changes requested, not just the instructions). 
 

View > Refresh 
This menu causes the window to be refreshed. 
 

View > Shortcuts 
This menu displays the Shortcuts toolbar if it has been closed. 
 

Filter > Set/Edit Filter 
This menu allows you to set or edit a filter for the Treatment Lengths displayed in 
the Bulk Review window. 
 



 

1 0 6  R A M M  F o r w a r d  W o r k  P r o g r a m m e  
 

Filter > Clear Filter 
This menu clears any filter that you have previously set. 
 

Shortcuts - Working With the Bulk Review 
This is a menu alternative to using the buttons on the Review Shortcuts toolbar. 
 

Returning to Normal Mode 
To return to the normal mode of the Forward Works window press the Review Mode 
button once again. 
 

Notes 
Notes can be added to either the Review Notes window or the Treatment Length 
Notes window. 

General notes can be added in the Treatment Length Notes window, and can only 
be edited by the party that added them (for example the Consultant cannot edit a 
note added by Transit New Zealand). Review notes are added in the Shortcuts 
window (as explained in Review Mode). 
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Ending a Review 
When the review of the Current Programme is complete you tell RAMM that the 
review is at an end by choosing the Actions > Review > Finish menu from the 
Programme Maintenance window in RAMM Manager. 

 

Choose the Network Management Area from those listed and click on the Finish 
button. 
 

Review Report 
You can look at the notes, status, and priorities for the Treatment Lengths that are 
not Ok using the Review Report. This report is available from the Programme 
Maintenance window in RAMM Manager by choosing the menu Actions > Review > 
Report. 
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The report will look something like this. 

 
 

Making the Requested Changes to the Programme 
Making the requested changes is done the same way as developing the programme 
- in the Forward Works window, the treatments can be moved by dragging and 
dropping them from where they are at present to where Transit New Zealand 
wants them to be. Treatments can be erased and new treatments added if 
necessary. 
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Review Status 
The status is changed automatically as the programme is edited. 

When the status of all the Treatment Lengths is "OK" the programme can be 
submitted to the annual plan. 

Step in Process Review Status 

Consultant constructs the Forward Work Programme. Proposed. 

Transit New Zealand reviews Treatment Lengths.  

No changes required. Ok. 

Changes required. Please Revise. 

Consultant makes requested changes. Changed. 

Transit New Zealand reviews again.  

No changes required. Ok. 

Changes required. Please Revise. 

 
 

Forward Work Programme Costs 
The cost of a Treatment Length for each year of the Twenty-Year Programme is 
calculated using the routine maintenance costs from the RMCE curve, the 
overhead cost of the cost set, the cost of the treatment and the costs of any MIS 
attached to the treatment (the latter two are used only if there is a treatment 
scheduled).  

§ The routine maintenance cost of the pavement and the surfacing is 
interpolated from an RMCE curve set against each cost set. 

§ If there are treatments present with an MIS attached, these MIS costs override 
the cost from the RMCE curve. 

§ A cost set is attached to each Treatment Length. 

§ The cost of a treatment is attached to a cost set. 

§ The cost of an MIS is attached to each cost set. 
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Setting Up To Calculate Costs 
The following must be done to enable the estimation of routine maintenance 
costs: 

§ The treatment costs for each cost set need to be entered. 

§ The MIS and MIS costs for each cost set need to be entered. 

§ The MIS for the year before and the year of treatment needs to be entered 
against each treatment.  

§ RMCE curve(s) need to be defined and attached to the cost set(s). 

§ Overhead costs for cyclic maintenance such as litter removal, grass mowing 
etc. need to be entered for each cost set. 

§ The reset of the RMCE curve needs to be defined for each treatment. 

Maintaining Treatments, Treatment Length Cost Sets, and Maintenance 
Intervention Strategies are discussed earlier in this document in the Preparing for 
Forward Work Planning section. 
 

Routine Maintenance Cost Estimation 
The RMCE curves are derived curves for a cost set that predict maintenance costs 
for any number of years into the future for all Treatment Lengths within that cost 
set. The curves can be produced by analysis of historic pavement and surfacing 
costs by seal age.  

There is a default curve in the database to provide a starting point, but Consultants 
will define their own curves as they analyse their region's maintenance costs and 
work out curves that best reflect their area. How far forward the curve estimates 
costs will reflect the areas maintenance costs - if a large cost (say $100,000/km/year 
+) is being incurred, then the curve may need to extend to a longer time-frame 
than ten or twenty years to accommodate the initial position on the curve, 
calculated from previous years maintenance costs. 

RMCE Curves are defined and maintained by Consultants. However, the 
information is retained in the database by means of the Forward Work Unload and 
Load that transfers it to the main databases held at Transit New Zealand. 
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Maintaining RMCE Curves 
RMCE Curve definitions are maintained in RAMM Manager. Access the 
maintenance window from the menu Projects > Forward Work > Routine Maintenance Cost 
Estimation. 

 

You need to define RMCE Curves for each of the Cost Sets that you have in the 
Network Management Area database. This is because the profile for different areas 
of the network may not be the same as each other. 
 

Duplicate Curve For Other TL Cost Sets 
If you wish to copy one RMCE Curve definition to another Cost Set then you can 
do so using the Duplicate Curve for other TL Cost Sets button. 

This displays the following that allows you to choose one or more of your other 
Cost Sets to copy the curve. 
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Tick one or more of the Cost Sets and click on OK to copy the RMCE Curve. 

Once the points on the curve have been defined, the curve is attached to a cost set. 
This is done via the RMCE tab on the Cost Set maintenance window. 

 

You need to choose from the list of RMCE Curves that are available for the 
highlighted Cost Set. 

If you have a standard Overhead charge that is to always be added to the RMCE 
cost at any point then enter a value here. 
 

Overhead Costs 
The figure in the Overhead box is to cover items that are not in the Pavement or 
Surfacing maintenance categories, such as litter removal, verge mowing and 
vegetation control. This is independent of the age of the seal, and is added onto the 
routine pavement and surfacing maintenance cost interpolated from the RMCE 
curve to get the total maintenance cost. 
 

RMCE Curve Reset after Treatment 
The Reset RMCE Curve drop-down menu contains three options - None, Reset to Midpoint 
and Reset to Zero. This defines what the maintenance costs will be in the year 
following the treatment. 

The way that costs are calculated for the year after the treatment depends on the 
setting for the Reset. 
 

None 
The curve continues on as it was. For example, if the year two years before the 
treatment was Year 5 of the curve, a Maintenance Intervention Strategy was 
applied to the next two years and the treatment did not reset the curve. The year 
after the treatment would then be Year 8 of the curve. 
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Midpoint 
The year the curve would have been on in the year of the treatment minus the life 
of the treatment as defined in the Treatments table, or zero which ever is greater. 
This is not actually the "Midpoint" of the RMCE curve, but it is more the 
midpoint of where the curve was before the treatment occurred with some 
adjustment for the expected life of the treatment. 
 

Zero 
The cost at Year 0 of the curve is applied to the year after the treatment.  

The graphs and tables below show the effects of the resets. They are based on the 
curve being on year three in 1998/99, with a Reseal with a five-year life ($30,000) 
in 2002/03, an MIS of Pre-reseal repairs ($20,000) in the year before the treatment, 
an MIS of Normal maintenance ($5,000) in the year of the treatment and an 
overhead cost of $1,000. Values of the curve are tabulated below. 
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Calculation of Programme Costs 
There are two places where you can calculate the Forward Work Programme costs 
for both Treatments and Routine Maintenance. They are the Forward Work 
Balancing window or the Status Check Dialog. 
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Calculating from Status Check 
Access Status Check from RAMM Manager using the menu Processes > Status Check. 

 

Choose the Forward Work Cost tasks and Calculate Forward Work Costs. 

If RAMM knows that the Forward Work Costs are out of date then this item will 
already be ticked. 

Once you begin processing you will see the following dialog asking you if you 
wish to calculate the costs for all Forward Work Programmes in the database or 
only those that are flagged as needing to be updated. 

 

Choose either option and you will see a process dialog similar to the following. 
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One of these dialogs will be displayed for each of the Forward Work Programmes 
where the costs are being calculated. 

As you can see this process will calculate the Treatment Costs followed by the 
Routine Maintenance Cost Estimates. 
 

Calculating from Balancing 
Open the Forward Work Balancing window and choose the menu Actions > Calculate 
to start the process running. 

This will then run the same processes as described above to calculate the 
Treatment and Routine Maintenance costs. 
 

Looking at the Treatment History 
When an End of Year Rollover has occurred any work that was planned in Year 1 
will be moved into the Treatment History. 

If you wish to see what Treatments have taken place in the past you can do so by 
referring to the Treatment Length. A tab called "Treatment History" is available on 
the Treatment Length Detail window in RAMM. 
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Any historical Treatment that took place on the Road, and whose location falls 
wholly or partially within the Treatment Length displacements, will be shown 
here. 
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Preparing for Forward Work Planning 
This section details what you need to do before you can set up and maintain a 
Forward Work Plan. We will look at creating an empty plan, setting up 
Treatments, Reasons, and other supporting information. 
 

Twenty-Year Programme 
The Forward Work Programme summarises maintenance and improvement 
treatments for all Treatment Lengths. The programme is prepared for the 
subsequent 20-year period. 

Controlling network management at project level is a continuous process. 
Constant assessment, reassessment and adjustment of treatments, Treatment 
Lengths and Maintenance Intervention Strategies are required. 

Pavement Maintenance Management is a dynamic process. As the pavement ages, 
deterioration will occur in different ways and at different rates. Continual 
assessment of the appropriateness and success of programmes and strategies will 
lead to quality decisions being made for future programmes and strategies. 

The alignment of understanding between Client, Consultant and Contractor 
should result in feedback being provided from all these parties. 
 

National and Local Lookup Tables 
Maintenance of look up tables is available in RAMM Manager. Some look up 
tables are nationally controlled, and the balance require some liaison with Transit 
New Zealand Regional staff before adding, changing or deleting entries. The data 

Lookup Codes 
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relationship between these tables is complex and care should be taken when 
maintaining them. 
 

Nationally Controlled Information 
Information in these tables is maintained by Transit New Zealand at Head Office. 
If you want to update or add to any of this information, please contact Transit 
New Zealand at your Regional Office and they will approach Head Office with 
your request. Updated national tables, for your Network Management Area, can 
be unloaded from the main database at Head Office, using National Table Export. 
When you receive the file you can load it into your regional database using the 
National Table Import. 

Nationally controlled information includes: 

§ Funding Groups. 

§ Maintenance Intervention Strategies (excluding costs). 

§ Note Types. 

§ Primary Motivators. 

§ Reasons. 

§ MARG Factors. 

§ MARG Weightings. 

§ MARG Activity / Defect Relationships. 

§ Safety Intervention Strategies. 

§ Treatments (excluding costs). 

§ Treatment Groups. 
 

Locally Controlled Information 
The following information must be developed locally to suit the needs of the 
Network Management Area: 

§ Treatment Length Cost Sets. 

§ Treatment Costs. 

§ Maintenance Intervention Strategy Costs. 

§ Routine Maintenance Cost Estimation. 

Having established the tables, the Treatment Length - Cost Set link must be 
established locally, and the treatment costs for each cost set generated. Cost Sets 
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operate in a similar manner to the cost sets that we are familiar with in the RAMM 
Treatment Selection Algorithm (TSA). 

Locally entered data is transferred back to Transit New Zealand, for input into the 
main database, using the Forward Work Unload/Load processes.  
 

Funding Groups 
Funding Groups represent a generic grouping of treatments into items under 
which funds will be sought. Grouping will be established on the basis of the 
criteria established in the Transfund Programme and Funding Manual. 
 

Maintaining Funding Groups 
Access the maintenance window from RAMM Manager using the menu Projects > 
Forward Work > Funding Groups. 

 

This information is nationally controlled and so cannot be maintained by 
Consultants accessing a database generated for them from the Transit New 
Zealand controlled copy. Contact Transit New Zealand if you want to add or 
update any Funding Groups. 

Updated Funding Group information can be delivered to the Consultant using the 
National Table Export/Import. 
 

Treatment Groups 
Treatment groups are established for network management purposes. 
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Maintaining Treatment Groups 
Access the maintenance window from RAMM Manager using the option Projects > 
Forward Work > Treatment Groups. 

 

This information is controlled by the Transit New Zealand and so cannot be 
maintained by Consultants accessing a database generated for them from the 
Transit New Zealand controlled copy. 

Updated Treatment Group information can be delivered to the Consultant using 
the National Table Export/Import. 

Some areas of Forward Work Planning need to know which Treatments indicate 
Reseal work. To do this a flag is set against one, and only one, of the Treatment 
Groups to indicate that all the Treatments that are part of this Group are Reseal. 
Setting this flag for one of the Treatment Groups will automatically cause all other 
Groups to have the flag set to "not reseals". 

The MARG Priority Index is used to indicate if Treatments belonging to this 
Group contribute (or not) to the Reseal Index or Pavement Area Treatment Index. 
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Treatments 
Treatments are the descriptions of the work types carried out to maintain the asset. 

In the Forward Work Programme the default treatment is a blank cell. This is 
taken to be routine maintenance. The value of the Treatment in any particular cell 
depends on a number of factors, for example, last Treatment, next Treatment, age 
relative to these and routine maintenance costs in the previous year. 

Treatments can be set up so that a percentage coverage can be applied. This value 
indicates the extent of work required, and the costs. Costs will obviously be 
applied against the percentage coverage specified. Percentage coverage can be set to 
apply to all treatment types, but is principally intended for work such as drainage 
improvements where these will typically only apply to part of the Treatment 
Length. Percentage coverage capability is set up using the flag in the administrative 
look up table maintenance function. 

The definitions for Treatments are nationally controlled and so must be defined 
by Transit New Zealand. Updated Treatment definitions can be supplied to the 
Consultant using the National Table Export/Import (see "National Tables Export" 
on page 165). 
 

Treatment Applicability 
Not all Treatments are available for use in the Forward Work Plan in any given 
Planning Year. The more general the Treatment definition the further out in the 
Programme you would use it. 

All Treatments defined in Forward Work Planning are assigned to one of the 
following Programme Periods: 

§ Years 1 to 4. 

§ Years 1 to 10. 

§ Years 1 to 20. 

§ Years 3 to 10. 

§ Years 11 to 20. 

Over time, processes such as the End of Year Rollover (on page 156) may cause 
some Treatments to move from a Year where they are valid to one where they are 
not. RAMM provides a report to allow you to quickly find these cases so that you 
can replace the Treatment with one more applicable to the Planning Year. 
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Treatment Life 
Each Treatment is expected to be effective for a limited period of time. This 
Treatment Life may vary between the different parts of your network. A Suggested 
Life is provided for each Treatment. This is defined by Transit New Zealand and 
delivered via the National Table Export/Import. However, since the Life of the 
Treatment can be different in each of the Areas. Consultants have the ability to 
assign their own value for the Treatment in the Network Management Area in 
their copy of the database. 
 

Inactive Treatments 
Over time Treatment definitions may change and there will be definitions that 
you no longer wish to be used in your Forward Work Programme. However, they 
may still be recorded in the Treatment History of work that has been completed in 
previous years. 

To ensure the history is retained you can flag Treatments as being Inactive. 
However, this does not automatically mean that those Treatments are removed or 
replaced in the Current or Alternative Programmes. To assist you to find Inactive 
Treatments in your plan RAMM provides an Inactive FWP Treatments Report 
(see "Inactive Forward Work Programme Treatments" on page 73). 
 

dTIMS Treatments 
RAMM Forward Work Planning has the facility to import information from a 
dTIMS analysis (see "dTIMS Analyses and Forward Work Planning" on page 162) 
and record it as an Alternative Scenario. 

Part of the information that is imported is the definitions for dTIMS Treatments. 
These are also recorded here together with the Forward Work Programme 
Treatments. To distinguish between them, RAMM flags all Treatments as 
originating in either Forward Work Planning or dTIMS. 

You can look at the details of dTIMS Treatments here, but cannot alter them. 
 



 

 C h a p t e r  1 2   –   L o o k u p  C o d e s  1 2 5   

Maintaining Treatments 
This can be accessed in RAMM Manager from the menu Projects > Forward Work > 
Treatments. 

 

Treatment definitions are nationally controlled. Transit New Zealand can make 
the definitions available to Consultants via the National Table Export/Import (see 
"National Tables Export" on page 165). 

When you insert a new Treatment you are required to assign it to a Funding and a 
Treatment Group. You are also required to state which Programme Period the 
Treatment is applicable for. Since only Forward Work Planning Treatments can be 
inserted here the Origin flag will default to NOMAD. The Suggested Life for the 
Treatment will default to 5 years, but you can update this to any value that you 
require. 

If you are at Transit New Zealand, entering a new Treatment, then you will not be 
allowed to enter any information on the Treatment Cost or Treatment Life tabs 
on this window. This information is specific to the Network Management Area 
and should be completed by a Consultant using their copy of the database. 

Tick the Allow Coverage flag if you wish to allow this Treatment to apply to a 
percentage of the Treatment Length. If Coverage is not allowed then the 
Treatment will be assumed to apply to 100% of the Treatment Length. 

If you wish to indicate that a Treatment is no longer applicable to the Current 
Forward Work Programme you should tick the Inactive flag. This means that the 
Treatment can no longer be used for future work. However, it may still exist in 
the Treatment History and this is acceptable to RAMM. 

RAMM provides a report, the Inactive FWP Treatments Report (see "Inactive 
Forward Work Programme Treatments" on page 73), which can be used to 
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determine where Inactive Treatments are present in the Current Programme so 
that they can be replaced with a more appropriate alternative. 
 

Treatment Life 
Treatments may have different lives depending on the local conditions in area of 
the Network that you are working in. To handle this Forward Work Planning 
allows the Consultant to define a different Life for the Treatment for each 
Network Management Area in their portion of the database. 

For new Treatments this will default to the Suggested Life defined by Transit 
New Zealand. 

 

Once the Consultant has recorded Treatment Lives for all the Network 
Management Areas in their copy of the database this information will be returned 
to Transit New Zealand using the Forward Work Unload/Load functionality. 
Transit New Zealand will be able to read this information but cannot update it. 

The treatment life is needed for calculating which year the RMCE curve will use 
after a treatment with a curve reset of "Reset to Midpoint" (how it is involved is 
explained in RMCE Curve Reset after Treatment). The life listed in the treatment 
table is different to that listed in the surface life table because traffic factors have 
been left out for simplicity - the calculation would become too complex and time 
consuming if the balancing programme had to go away and look at the traffic of 
the Treatment Length to determine the life of the treatment. 
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Treatment Costs 
The cost of applying a Treatment will vary between, and within, Network 
Management Areas as a result of local conditions. RAMM allows Consultants to 
record the cost for each Treatment for each of the Cost Sets that have been 
defined. The section on Treatment Cost Sets (on page 127) has a more detailed 
explanation of their definition and use. 

 

Once the Consultant has recorded Treatment Costs for all the Cost Sets in their 
Network Management Areas this information will be returned to Transit New 
Zealand using the Forward Work Unload/Load functionality. Transit New 
Zealand will be able to read this information but cannot update it. 
 

Treatment Cost Sets 
Treatment Cost Sets as used in the Twenty-Year Programme are synonymous with the 
cost sets used in Treatment Selection, that is they exist on a one to one basis, are 
known by the same name and apply over the same area. For Twenty-Year 
Programming, the costs of the treatments specified in the treatment table are 
attached. 

To change the cost set to which a particular Treatment Length is associated, edit 
the cost set field on the Treatment Length view window. This change will then 
apply to both treatment selection and the Twenty-Year Programme financial 
calculations. 

In all cases the costs are based on units of $/km. 
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Maintaining Treatment Cost Sets 
Access Treatment Cost Sets through the RAMM Manager menu Maintenance > 
Lookups > Carriageway > Cost Sets. 
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Cost Sets can be defined either by Transit New Zealand or the Consultant. New 
Cost Sets defined by the Consultant will be transferred to Transit New Zealand 
through the Forward Work Unload/Load function. 

New Cost Sets are automatically numbered according the range allowed for each 
Network Management Area. If no range is defined for the Network Management 
Area (as would normally apply in a Local Authority database) then the Cost Sets 
will be numbered from 1. 

When you insert a new Cost Set RAMM will automatically create one row for 
each of the active Treatments that are flagged with an Origin of NOMAD. The 
Unit Cost, which is expressed in $ per km, will default to zero and can be updated 
as required. This information is the same as that displayed for individual 
Treatments on the Treatment maintenance window and you can edit it from 
either place. 
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This window also allows you to define which Cost Set each of the Treatment 
Lengths will use. Although you can assign a Cost Set by maintaining the 
Treatment Length in RAMM, you can also do it here by highlighting one or more 
Treatment Lengths, selecting a Cost Set from the "Move to cost set" combo box 
and clicking on the "Move" button. 

 

If you intend using Routine Maintenance Cost Estimation (RMCE) you will need 
to define an Overhead Cost to the Cost Set and associate it with a RMCE Curve. 

Additional information on the Detail tab that is used in the RMCE calculation is 
the Maintenance Intervention Strategy which is to be applied to the year in which 
the Treatment takes place and that for the year just previous to the one where the 
Treatment takes place. Maintenance Intervention Strategies (on page 158) have 
costs associated with them and so impact on the RMCE. 

Finally on the Detail tab is a RMCE Reset option. This also has an impact on the 
RMCE calculation and needs to be considered if you wish to use this 
functionality. 
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This table holds all the treatments that are recognised in the database as well as the 
groups they are in (funding and treatment), their expected life and their unit costs 
by cost set.  

The pull-down menus titled "MIS (Year of Treatment)" and "MIS (Year 
Preceding)" are where the MIS for the treatment are attached. If an MIS is selected 
for either of these years, the maintenance costs given by the RMCE curve will be 
overridden with the figure defined in the Maintenance Intervention Strategy 
window for the particular cost set. For example, if the treatment was a reseal, the 
MIS for the year preceding the reseal may be Pre-Reseal Repairs (to reflect the 
increased of maintenance to bring the Treatment Length to the ideal condition for 
sealing), and the MIS of the year of the Treatment may be normal maintenance (to 
keep the Treatment Length in the same condition).  

The Consultant needs to decide what the MIS (if any) will be for each treatment. 
If it is decided there will be no special maintenance for a Treatment then leave the 
two MIS columns blank. For example, a Treatment such as shoulder grading may 
have no impact on the interpolated costs and accordingly the MIS will be left 
blank. 
 

Maintaining Cost Set Ranges 
The range of allowed values that can be used for your Cost Set Identifier is defined 
by Transit New Zealand. Each Network Management Area is assigned its own 
unique range of numbers. 

You can maintain Carriageway Area definitions in RAMM Manager from the 
menu Maintenance > Lookups > Carriageway > Cway Area/Sub Area. 

 

Care should be taken when maintaining information for the Carriageway Area. 
The transfer of information between Transit New Zealand and Consultants 
depends on the Carriageway Area name and the Cost Set Number. If the name of 
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the Carriageway Area is changed in one database and not the other then there will 
be problems with the Forward Work Load rejecting the file Unloaded from the 
other database.  

If the Cost Set Number Range is incorrectly set so that it overlaps the range 
assigned to another Network Management Area in the same Transit New Zealand 
main database, then the FWP Load will overwrite the wrong Cost Set definition 
and vital information will be lost. 
 

Reasons 
Reasons are the explanations of why a given Treatment will be carried out when 
maintaining the asset. One or more reasons must be entered for every Planning 
Year when you assign at least one Treatment. 

RAMM Forward Work Planning allows information from dTIMS analyses to be 
loaded as Alternative Scenarios. Whilst dTIMS does not explicitly define a Reason 
for each of its Treatments, RAMM requires one. Therefore, RAMM will 
automatically create a Reason called "dTIMS Recommendation" and flag it with an 
Origin of dTIMS. All other Reasons are defined as having an origin of NOMAD. 
 

Maintaining Reasons 
Reason definitions can be maintained in RAMM Manager by accessing the menu 
Projects > Forward Work > Reasons. 

 

When inserting a new Reason definition you will need to supply the Code and the 
Description. For all new Reasons the Origin will be set to NOMAD. Details of 
dTIMS Reasons can be viewed here but are as a result of the load of a dTIMS 
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Analysis only. See the section on dTIMS Analyses and Forward Work Planning 
(on page 162) for further details. 

Each Reason can have none, one, or more Primary Motivators associated with it. A 
Primary Motivator is a definition of the underlying cause for the Reason when it 
has been assigned to a planned Treatment. 

You can tell RAMM that you require further details to be entered into the 
Programme when a given Reason has been assigned. This is done by ticking the 
"Notes are required when using this reason" option. This ensures that RAMM 
requests a Reason Note to be entered whenever this Reason is used. 

Reason definitions are nationally maintained by Transit New Zealand. New and 
updated definitions can be provided to the Consultant via the National Table 
Export/Import (see "National Tables Export" on page 165) process. 
 

Primary Motivators 
Maintenance for the Primary Motivator is through RAMM Manager using the 
menu Projects > Forward Work > Primary Motivator. 

 

When entering a new Primary Motivator you will need to supply both a Code and 
Description. You can optionally include some notes to enhance the definition. 

Primary Motivator definitions are nationally maintained by Transit New Zealand. 
New and updated definitions can be provided to the Consultant via the National 
Table Export/Import process (see "National Tables Export" on page 165). 
 

Note Types 
Note Types are used to categorise the free format notes available for entry against 
the Current Forward Work Programme or any alternative scenario. 
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Maintaining Note Types 
Note Types can be added and maintained in RAMM Manager from the menu 
Projects > Forward Work > Note Types. 

 

This information is maintained by Transit New Zealand. 

Updated Note Types can be obtained from Transit New Zealand using the 
National Table Export/Import process (see "National Tables Export" on page 165). 
 

Maintaining Overview Tolerances 
This window allows you to set up Tolerance Years and a percentage variation for 
each Tolerance Year. 

Select RAMM Manager > Projects > Forward Work > Overview Tolerance to launch this window. 

 

These options control how the Overview Report (on page 92) is generated. 
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Programme Maintenance 
Programme Maintenance allows you to manage multiple Forward Work 
Programmes. When you next use the Forward Work Programme features within 
RAMM for Windows you will be able to choose the Programme to work with. 
Use this window to copy, archive, print and manage your Programmes. 
 

Managing Programmes 
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Maintaining Forward Work Programme Headers 
The maintenance of Forward Work Programme Headers is carried out in RAMM 
Manager from the menu Projects > Forward Work > Programmes. 

 

If you do not have any Forward Work Programmes defined in your database then 
the first time that you enter this window a Current Programme will be 
automatically created for you. By default the name of this Programme will be 
"Current Programme" but you can change this at any time. 

Apart from the name of the Programme, the Author, and the Notes nothing else 
on this window can be changed by directly editing the field on the window. All 
changes and other maintenance functions are accessed from the Actions or Reports 
menus. 
 

First Year 
The First Year indicates the Financial Year corresponding to Year 1 of the Forward 
Work Programme. Year 1 is the Current Financial Year and any work planned for 
that year should have been approved and already be taking place. The First Year 
only changes when you perform an End of Year Rollover on the database. This is a 
Transit New Zealand function that is described more fully in our section on End 
of Year Rollover (on page 156). 
 

Lock Mode 
The Lock Mode is an indication of the state of the Programme. It can be 
Programmable, which means that you can maintain full details of the Programme, 
Locked, which means that you cannot change the Programme, or Review only, 
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which means that the Programme has been created as a copy of the Current 
Programme for use during the Review. See the section on the Reviewing the 
Forward Work Programme (on page 95) for more details. As a Consultant, any 
changes that you make to a Programme that you have unlocked may be lost when 
Transit New Zealand returns a copy of the database to you. 
 

Format 
The Format of the Programme can be Current, Archived, Linked, or dTIMS 
Recommendation. Only one Programme can be the Current Programme. Copies 
of the Current or other Programmes are set with a Format of Linked. If you 
choose to Archive a Programme then the Format will be set to Archived. Archive 
Programmes retain only their cost information. All other information will be lost. 

Only Programmes that have been loaded from dTIMS Analysis data will have the 
Format of dTIMS Recommendation. 
 

dTIMS Analysis Date 
The dTIMS Analysis Date is information that is loaded from the dTIMS Analysis 
and indicates the date when that analysis was carried out in dTIMS. It is not the 
date when you loaded the analysis into RAMM but the date, from dTIMS, when 
the analysis was carried out. 
 

Actions > Duplicate 
This option will create a copy of the highlighted Programme. By default the new 
copy will have the same title as the original with the text "Copy of" attached to the 
front. You can rename it to suit yourself. 

This programme will also be given the Format of "Linked" to indicate that it is not 
the Current Programme, but is derived from it. 
 

Actions > Archive 
Use this menu to archive the highlighted Programme. Detailed information on 
each Treatment Length is deleted from the Programme including Treatments, 
Reasons, Status, Priority, Maintenance and Safety Intervention Strategies. 
Treatment Length Notes are unaffected by archiving. Once archived a Programme 
can only be viewed in RAMM through the Forward Work Balancing window and 
summary reports produced. Archive Programmes are ones that you have finished 
with, but where you wish to retain an overview for reference only. 
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Actions > Lock/Unlock Programme 
Use this menu to either lock a Programme that is Unlocked or to unlock a 
previously Locked Programme. You can lock a Programme yourself if you wish to 
ensure that you do not accidentally change any of the details. If you unload a 
Programme using the Forward Work Unload/Load it will automatically be locked. 
You can still unlock an unloaded Programme but you will be warned that any 
changes you make may be lost if the Programme is returned. Returning a 
Programme through the FWP Load will also unlock it. 
 

Actions > Make Current 
Use this option to set the highlighted Programme to be the Current Programme. 
Remember, that only one Programme can be Current at any one time, so setting 
the highlighted Programme to Current will cause the former Current Programme 
to be set as Linked. This is not available for Archived Programmes or those loaded 
from a dTIMS Analysis. 
 

Actions > Review 
These options are used when reviewing a Programme. See the section on the 
Reviewing the Forward Work Programme (on page 95). 
 

Reports > Detail Report 
This is another way to access the Forward Work Detail Report. Please see Forward 
Work Detail Report (on page 82) for more information. 
 

Reports > Review 
This option is used when reviewing a Programme. Please see the section on 
Reviewing the Forward Work Programme (on page 95). 
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Deleting a Forward Work Programme 
You cannot delete the Current Forward Work Programme in RAMM. If you 
genuinely wish to delete the Programme you are currently working on, you must 
first set one of your Alternative Scenarios to be the Current Programme. You will 
then be able to delete the one you wanted to delete originally. 

If the Programme you are deleting is a simple copy of the Current Programme 
(that is an alternative that you have set up) then you will be prompted to confirm 
the deletion but having done that the Programme will be deleted. 

However, if the Programme that you intend deleting is one created as part of a 
Review of the Current Programme then you will see the following dialog 
displayed. 

 

You can then choose to keep the Review Notes from the Programme you are 
deleting or to remove those as well. 
 

Programme Development 
The Twenty-Year Programme produced by the intellectual process is an indicative 
assessment. Rehabilitation and improvement works identified, are then subject to 
more rigorous economic and engineering scrutiny. 

Once funding levels are confirmed, the Twenty-Year Programme will be reviewed 
to ensure rejected proposals have appropriate Maintenance Intervention Strategies applied. 
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Preparing the Forward Work Programme 
The site assessment should identify possible solutions. These need to be costed 
and quantified against economic criteria or by economic awareness to determine 
the most economically acceptable solution. A priority will need to be allocated 
against each treatment. 

Treatments may be determined by referencing other sources of information. This 
may include safety improvements or other improvement works separately 
investigated. The status, timing and economic viability of these projects will need 
to be determined and recognised prior to inclusion in the Twenty-Year 
Programme and allocation of a Maintenance Intervention Strategy. 
 

Maintenance Functions 
Maintenance of the Twenty-Year Programme and supporting files will generally 
follow the following pattern. 

1 Maintain look up tables. 

2 Review treatments. 

3 Review and maintain cost sets. 

4 Review Maintenance Intervention Strategies. 

5 Review Safety Intervention Strategies. 

6 Review intervention levels for the exception reporting. 

7 Run exception reports (Treatment Lengths generating an exception in 
condition data will be flagged). 

8 Review treatments - office exercise. Use the exceptions generated and/or 
associated condition data. 

9 Review treatments - field review. 
 

Performance Monitoring 
The constant evaluation of the degree of success of selected treatments will enable 
greater confidence to be provided to future treatment selection evaluations. 
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Performance monitoring and the associated feedback is critical to the development 
of the intellectual process. 
 

Assessing Your Data 
Prior to any field assessment of Treatment Lengths being made, data needs to be 
collated and interpreted to determine the trends and exceptions described in 
Trends and Exceptions (on page 74). 
 

Importance 
The bulk of maintenance expenditure is likely to occur over a small percentage of 
the network. When cumulative expenditure is plotted against cumulative length 
65% of expenditure occurs over 20% of the length of the network. 

Data collection and analysis will allow the 20% of the network with high 
maintenance costs to be more readily identified and Treatments and Maintenance 
Intervention Strategies formulated to reduce maintenance costs. An improvement in 
maintenance programmes and strategies will result in a trend towards a straight 
line (an even distribution of needs). 
 

Assessing the Programme in the Field 
Treatment Lengths that have trends and exceptions noted are targeted for field 
assessment. The field assessment will require visual inspection of the site to 
determine: 

§ Is there is a problem as indicated by the trend or exceptions? 

§ Is there is any other problem associated with the site? 

§ What is the cause of the identified problem? 

§ What is the extent of the problem?  

§ Is local or area treatment appropriate? 

§ What are acceptable solutions? 
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Unloading Programmes 
Use the Forward Work Unload function to unload a selection of programmes to 
be delivered to Transit New Zealand.  
 

Programmes 
Programmes to be unloaded can be chosen from a list containing all programmes 
in the database. Programmes changed or created since the database was sent to you 
are automatically checked. The current programme is automatically included in the 
programmes to unload and cannot be unchecked.  

WARNING: Any changed programmes that are not sent will not appear in the next 
database Transit New Zealand delivers to you. 

 

Unload 
During the unload; the status of treatments is switched from Changed to Proposed 
for each chosen programme and the programmes Locked. The programmes are 
locked to prevent changes being made until Transit New Zealand delivers a new 
database. Programmes sent from Transit New Zealand are always Unlocked. 

To unlock a programme yourself and continue working with it, use the Projects > 
Forward Work > Programmes menu option in RAMM Manager. If you do this you must 
ensure another Unload is sent before you next receive a database unload from 
Transit New Zealand or your work will be lost. 
 

Save as type 
All data for the chosen programmes is unloaded to a single compressed file with an 
.FWU extension. 
 

Email 
The .fwu file created can be emailed to Transit New Zealand for loading into their 
programme. 
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Programme Unload (Transit New Zealand/Consultant) 
§ After giving RAMM Manager exclusive access to the database, Projects > Forward 

Work > Unload  

§ Status on the unloaded programmes changes to locked when either user 
unloads. 

The status automatically changes to locked to prevent any changes being made 
while the other party has the programme, as these changes will be lost if they are 
not unloaded before the programme received from the other party is loaded. The 
programme can be unlocked in RAMM Manager using the menu Projects > Forward 
Work > Programmes, select the programme, then Actions > Unlock Programme. 

 

Choose the destination directory and the name for the Unload file. Then click on 
the Unload button to start the process. 

 

Once the unload is complete click on the Close button. The file is now ready to be 
sent to Transit New Zealand. 
 

Loading Programmes 
This process loads programmes, sent by consultants, into the Transit New 
Zealand database. The contents of the load file are displayed and the programmes 
to be loaded offered. The Programme Load wizard will guide you through choices 
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on which programmes to load, whether to create a copy of the programmes being 
overwritten, managing alternative scenarios when Treatment Lengths have 
changed or programmes are in review. 
 

Loading Implementation Steps 
The following implementation steps are carried out by Transit New Zealand 
before unloading the database for dispatch to Consultants. 

4 Loading Implementation Steps 

1 Maintain nationally controlled lookup tables (see "National and Local Lookup 
Tables" on page 119). 

2 Summarise Treatment Lengths. This process summarises key data to the 
Treatment Length level. For example, roughness statistics (mean, maximum, 
etc). The database will then be unloaded and released. Implementation should 
then continue as below. 

3 Complete lookup table creation - Regionally controlled tables. (Liaison with 
Regional Transit New Zealand Staff is essential) 

4 Maintain Treatment Lengths. Maintain the system generated Treatment 
Lengths to match the physical layout appropriate. The Generate Treatment 
Length process will create Treatment Length joints at all Major Seal Joints. 
These may not match the joints considered appropriate locally. 

5 Maintain the cost sets attached to the Treatment Lengths. The generate 
function defaults these to the same cost sets currently attached for treatment 
selection. If these are not adequately set up to reflect changes in costs 
associated with area treatments, maintenance will be required. 

6 Attach Treatments, Reasons, Maintenance Intervention Strategies, Safety 
Interventions, Priority and Notes to the Treatment Lengths.  

7 Check for the appropriateness of the balance of the programme. This step 
involves consideration of the total length and cost of the various treatments 
across the twenty year planning period: essentially, looking for peaks and 
ensuring that they are justified. Some re-evaluation of treatments may be 
required to achieve an appropriate balance. 

The programme is then ready for downloading and returning to Transit New 
Zealand. 
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To Load Programmes 

4 How To Load Programmes: 

1 Create a backup of the database. Use the database backup facilities in RAMM 
Manager (File > Backup Database) to create a backup of your database. 

2 Select a Forward Work Archive. Select the forward work archive file (.fwu file 
extension) sent from the consultant. 

3 After selecting the archive, use the load wizard to select load options. Up to 
three windows are presented: 

§ Programme Contents - shows the programmes being delivered and the 
contract areas covered. 

§ Treatment Lengths have Changed - only shown if the consultant has changed 
Treatment Lengths. 

§ Programmes Under Review - only displayed if programmes are being 
reviewed. 

Once the load routine is completed, the database into which the load was 
performed has an exact copy of the Treatment Lengths and programme 
information unloaded from the consultant's database. 
 

Load Programme Contents 
All programmes in your database are displayed in this panel plus new ones created 
by the consultant. Columns are used as follows: 

§ Current - shows the current programme on your database.  

§ Received - this is ticked for all programmes changed and returned by the 
consultant or shows New for all new programmes 

§ Copy - tick any programmes being returned if you want a copy saved before 
loading the consultant's version. The copy can be viewed and maintained just 
like other alternative or scenario programmes. 
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Loading Changed Treatment Lengths 
This window is displayed because the Treatment Lengths in the database are 
different from those delivered from the consultant. The new or changed 
Treatment Lengths from the consultant will be loaded, replacing any Treatment 
Lengths covering the same carriageway length. Only Treatment Lengths for the 
contract areas being loaded are changed. 

The treatments in alternative (scenario) programmes covering these Treatment 
Lengths will be cleared. If a new programme has not been delivered by the 
consultant, there are two options for how to deal with these Treatment Lengths 
that have no forward work programme: 

§ Blanks - leave the programme blank. 

§ Current - schedule the same treatments scheduled in the current programme. 
 

Loading Under Review 
This window shows programmes currently in Review. If a programme is received 
while a review is under way you must decide whether to delete the review and 
restart from scratch or continue with the review. If you choose to continue you 
may have already made comments about treatments that the consultant has now 
changed. The comments may be irrelevant and at worst confusing. 
 

Invalid Load 
When there are rows that do not link to roads or carriageway sections these are 
listed in a grid and you may fix the errors. The only rows displayed are those that 
are in error. A filter option is available if you wish to further refine the rows 
displayed. You can only update or delete rows. On completion the validation is 
run again either until there are no problems with the data or you press Cancel. Two 
buttons are available to make corrections easier.  

§ Correct Carriageways  

§ Correct Roads  
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These buttons are designed to handle the majority of the cases, however there a 
number of more complex changes that cannot be handled by routines (for instance 
Splitting a Road will involve redefining the start and end displacements, not just 
attaching to a new road and carriageway section). You can either make these 
changes manually or return the data and a list of changes that have occurred to the 
roadnames and carriageway table to the data supplier for correction. 

The filter button enables you to filter the information. When a filter is currently in 
use the word Filtered appears on the window title bar. 
 

Correct Carriageway 
The Correct Carriageways button will appear if there are records located within the 
wrong carriageway sections. This button will automatically locate these records 
and place them in the correct carriageway section. If there are two displacement 
columns in the table (for example start_m and end_m) then you must choose which 
one is used to determine the correct carriageway section. When a row does not sit 
within a carriageway section the column carrway_start_m is left as it is. 
 

Correct Roads 
The Correct Roads button will appear if there are records that do not link to the 
roadnames table. The Road ID of the current row is defaulted into the Invalid Road ID 
column. You can either enter the correct Road ID directly into the Correct Road ID 
column or select the roadnames from the pull down list available on the Correct Road 
column. Clicking the Correct button will apply the change. 
 

Programme Load (Transit New Zealand/Consultant) 
§ After giving RAMM Manager exclusive access to the database, choose Projects > 

Forward Work > Load.  

§ Status of the loaded programme changes to unlocked and editable for a 
Consultant user, and unlocked but not editable for a Transit New Zealand 
user. 

There will be a forward works programme that is the current programme (although not 
necessarily called "Current") in the database. The programme that is being loaded 
will overwrite this programme. Therefore, the option to make a copy of the 
existing current programme is given to you. By default the name of this copy will 
be the same as the original but with the text "Copy of" appended to the front. It is 
recommended that this be renamed if it is going to be retained, to reduce 
confusion later in the year when there may be many programmes with the same 
name. This can be done in RAMM Manager from the menu Projects > Forward Work > 
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Programmes, select the programme and type the new name in the box at the top 
right. 

Select the file to be loaded by browsing. 

 

When you have selected the file to be loaded click on the Open button and you'll see 
the following information. 

 

You are warned that by loading this file you may well cause Treatment Lengths to 
be changed in your database. As part of the preparation of the Forward Work 
Programme your Consultant may have changed the Treatment Lengths in their 
Network Management Area. These changes will be implemented in the Transit 
New Zealand copy of the database as the Programme is loaded. 

It is recommended, in case there is a problem, that you take a backup either by 
backing up the entire database or by unloading your own copy of the Forward 
Work Programme before loading the one from the Consultant. Your unloaded 
copy will have a record of the Treatment Lengths as they are before the 
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Consultant's Programme changes them and you can use this to restore the 
database back to where it was before. 

The Programme Contents part of this window displays details of the Network 
Management Area(s) and Programme(s) that are present in the unload file. Use 
this information to confirm that you have the correct information before 
continuing with the load. 

The Programmes listed on this window include all those currently in your 
database plus an indication of whether you are receiving a new copy of that 
Programme from your Consultant. 

Finally, you can indicate if you wish to make a copy of any one of your existing 
Programmes before the incoming one replaces it. 

Once you have made your choices click on the Next button to continue. 

You then need to decide what you want to do to Programmes (other than the 
Current Programme) when Treatment Lengths have changed. 

For the affected Treatment Lengths you can choose an Action to set those 
Programmes to be Blank, Archived, or to take the Treatment from the incoming Current 
Programme. 
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When Transit New Zealand loads the programme from the Consultant after the 
first review has been conducted, they will be asked if they want to carry on the 
review or abort it (default).  

Click on the Next button to see details of the Programme that is under review and 
to decide whether to continue with the review or not. 

 

Once you have made your decisions on whether to Abort or Continue the Review, 
click on the Finish button to load the information from the Unload file. 

 

When this process has completed the new Forward Work Programmes will be 
available to work with. 

If RAMM encounters a problem during the load process it will abort the process 
and restore the original Forward Work Programmes and Treatment Lengths. 
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Loaded Programme Report 
A record is kept of all the Forward Work Programme loads that have taken place. If 
you wish to review that history a report is available in RAMM Manager from the 
menu Reports > Forward Work > Loaded Programme Report. 

 

You can filter the information passed to the report by selecting a specific Network 
Management Area or by setting the dates that you are interested in. 

The finished report will look something like this. 
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IN  THIS  CHAPTER 
Creating a Database for your Consultant .................................153 
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What Else Can I Do with RAMM Forward Work Planning? ..160 

 
 

Creating a Database for your Consultant 
As part of the planning cycle, Transit New Zealand will create extracts of the main 
database for each of the Network Management Areas. These extracts will be sent 
to their Consultants. 

This section deals with the creation of the Consultant databases and how 
Consultants import them. 
 

Database Export 
You can export all or part of your Network using the Database Export function 
that is available in RAMM Manager from the menu File > Database Export. 

 

National Tasks 
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Go to the Network tab to choose the portion of your network that you wish to 
export. Transit New Zealand returning a Network Management Area to the 
Consultant, should use this tab to select the appropriate NMA. 

 

If you wish to exclude a portion of the information in the database you can do so 
by choosing some of the systems listed on the RAMM System tab. 

 

When you have finished making your selections, click on the OK button to start the 
export. 
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Database Import 
When a Consultant receives a database from Transit New Zealand it can be used 
to create a new database using the Database Import. This is available in RAMM 
Manager from the menu File > Database Import. 

Use the browse window to locate the database export file. 

 

Select your file and click on Open to begin the import. 

 

It is advisable to choose to create a new database from this file rather than 
replacing any existing copy. 
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End of Year Rollover 
The End of Year Rollover process can only be run by Transit New Zealand against 
the master databases. 

Run this rollover process to setup your database ready for planning treatments for 
the next season.  
 

Tasks Performed 
The rollover process performs the following tasks: 

§ Rollover - The year displayed in the first column of the programme is moved 
forward one year. For example, if 2002/03 used to be the first year, after 
rollover 2003/04 will show as the first year.  

§ History - Treatments scheduled for Year 1, prior to the rollover, are recorded in 
a history table. These can be viewed from the RAMM Treatment Length 
detail window. 

§ Delete Year 1 - Reasons, reason notes, priority, targets and status for Year 1 are 
deleted. 

§ Maintenance Intervention Strategy reset - If the treatments now placed in Year 1 or Year 
2 of the programme have changed, the MIS is reset to null.  

§ Force Balancing Window Recalculation - When a programme is next displayed in the 
Balancing window the system will recalculate the programme costs. 

 

End of Year Rollover Preparation 
To prepare for running the rollover check the following: 

§ Confirm compatibility will be maintained. 
When unloading and loading programmes, the first year of the loaded 
programmes must be the same as the programmes in the target database. If 
there is any mismatch the load will abort. Be sure other users you may wish to 
load programmes from, or send programmes to, are using the same year. 

§ Backup.  
End of Year rollover makes major changes to the database that are non-reversible. 
Create a backup of the database. Use the Database Backup facility in RAMM 
Manager to make a copy of your database before performing the End of Year 
Rollover. 
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§ Check Safety Intervention Strategies. 
Some Safety Intervention Strategies may now be able to be cleared. This is not 
done automatically during the rollover since some Safety Intervention 
Strategies must remain after treatment work is completed (for example the SIS 
may be long term or not corrected by the programmed treatment).  
 
It is easiest to review the SIS prior to rollover, using the Forward Work 
Programme window in RAMM. This shows the treatments in Year 1 and allows 
SIS maintenance. The SIS review can be done after the rollover, using the 
Treatment History tab of the Treatment Length detail window and the 
Forward Work Programme window. 

§ Check Treatments in Year 1? 
Is the correct programme selected as the current programme? 
It is assumed all treatments in Year 1 of the current programme have been 
contracted and completed. Check that Year 1 of the current programme 
accurately reflects the work done, as this will be recorded in the Treatment 
History. 

 

Performing the End of Year Rollover 
The End of Year Rollover process is only available to Transit New Zealand when 
using the Transit New Zealand master database. You can get to this function from 
RAMM Manager using the menu Projects > Forward Work > EOY Rollover. 
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The most important thing to note about the End of Year Rollover process is that it is 
irreversible. Once this process has run there is no going back. The only way to get 
back to the position you were in before is to restore a database backup. 

The End of Year Rollover is used to tell RAMM that we are now in a new financial 
year. All Treatments currently defined as taking place in Year 1 are now assumed 
to have taken place. Therefore, this information is moved from Year 1 into the 
History. 

The only information that goes into the History is the Treatment and where on 
the network it took place (Road and Displacement). The formal link between the 
Treatment and a Treatment Length is broken at this point. We do this because 
Treatment Lengths are dynamic in RAMM and may change considerably over 
time. However, the Road definition is not so volatile and we can use this to record 
the location of historical Treatments. 

Information about the Reason, Primary Motivator, Reason Notes, etc will be lost. 

Once Year 1 information has been placed into the history all the other Years move 
one forward. That is Year 2 becomes Year 1, Year 3 becomes Year 2, and so on. A 
new, blank year is made available for Year 20. 
 

Effects of End of Year Rollover 
This movement of Treatments has some side effects that you also need to be aware 
of. 
 

Maintenance Intervention Strategies 
Part of the normal Forward Work Planning process is to delete the Maintenance 
Intervention Strategy for a Treatment Length whenever a change is made to the 
Treatments in Years 1 to 3. 

End of Year Rollover affects all Years 1 through 3, so if there was a Treatment 
present in any one of those Years the MIS will be deleted. 

It is the responsibility of the Consultant to ensure that any missing Maintenance 
Intervention Strategies are replaced. Using the Forward Work Programme 
Planning Grid you should be able to find all the Treatment Lengths that are 
affected. 
 

MARG Priorities 
MARG values are calculated for Year 2 of the Forward Work Programme. 
Therefore, since Year 2 has become Year 1 after the Rollover, the values we have 
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previously calculated no longer apply. To avoid confusion the MARG values are 
completely cleared for the database. 
 

Safety Intervention Strategies 
The End of Year Rollover does not alter safety Intervention Strategies. However, it 
would be sensible to review them when the new Consultant copy of the database 
has been received. 
 

Allowed Treatments 
Treatments are defined by Transit New Zealand as being applicable only for 
certain Years in the Forward Work Plan. 

End of Year Rollover can cause some Treatments to move from a Year where they 
are valid into a Year where they are not. 

Finding these Treatments by visually scanning through the Programme is not an 
easy task. Therefore, RAMM provides you with a report to assist. 

The Out-of-Date FWP Treatments report can be accessed from RAMM Manager 
using the menu Reports > Forward Work > Out-of-date FWP Treatments. 

It is the responsibility of Consultants to update the Forward Work Plan to replace 
any out-of-date Treatments with more appropriate alternatives. Therefore, it is 
recommended that you run this report as soon as you receive a new copy of the 
Consultant database following End of Year Rollover. 
 

Primary Motivators 
Primary Motivators are required for all Reasons that have them defined, when 
those Reasons are used in Years 1 to 5. This means that any Reason used in Year 6, 
that you did not assign a Primary Motivator to is now in error as it moves into Year 
5. 

Like, Treatments this is a difficult thing to scan for visually and so RAMM 
provides you with a Missing Primary Motivators report. You can access this report 
in RAMM Manager from the menu Reports > Forward Work > Missing Primary Motivators. 

It is the Consultants responsibility to ensure that all Reasons that require a 
Primary Motivator have an appropriate on assigned. Therefore, it is recommended 
that you run this report as soon as you receive a new copy of the Consultant 
database following End of Year Rollover. 
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Inactive Treatments 
Inactive Treatments have no connection with End of Year Rollover and therefore 
shouldn't be a cause for concern. However after performing an End of Year 
Rollover it would be advisable to check for Inactive Treatments still in the 
Programme. 

From time to time Transit New Zealand decides that a given Treatment is no 
longer applicable. Since we need to keep the historical references to it, we cannot 
remove it from the system. 

However, the process of flagging a Treatment as Inactive does not force any 
changes to the Plan. 

Once you receive a new copy of the Consultant database following the End of Year 
Rollover it is recommended that you look for and replace any Treatments that are 
now inactive. RAMM provides a report to help you locate any of these cases. You 
can get to the report in RAMM Manager from the menu Reports > Forward Work > 
Inactive FWP Treatments. 
 

What Else Can I Do with RAMM Forward Work Planning? 
There are a number of other tasks that can be performed within the RAMM 
Forward Work Programme. They will not be things that you would do every day. 
These tasks are: 

§ Combine All Programmes. 

§ Unload RAMM Data for dTIMS. 

§ Load dTIMS Analyses. 

§ National Table Export. 

§ National Table Import. 
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Combine All Programmes 
Combine All Programmes is the process by which the Forward Work 
Programmes, from two or more databases, can be combined into the current 
database. One combined Current Programme is created from those in the source 
databases. 

Connect to the database that is to be the destination for the combined Forward 
Work Programmes and choose the databases that will be used to provide the 
source data. 

Note that this process will remove all Programmes in the destination database 
before generating the new combined Programme. 

This option is only available to Transit New Zealand, using the RCA master 
databases. Access to this function is in RAMM Manager using the Projects > Forward 
Work > Combine All menu. 

 

Remember that the database that you are currently connected to, whose name 
appears in the window title, is going to be used as the destination for all the source 
databases. 

This means that anything that is currently recorded in this database will be deleted and 
replaced with the incoming information. 

Select your source databases from the list available on this window. The databases 
that you choose will only have information read from them and will not be altered 
or affected in any way. 

The Combine All Programmes process is intended to be run when connected to 
the RAMM8 database, which is a blank database specifically created for this 
purpose. 
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dTIMS Analyses and Forward Work Planning 
dTIMS is a tool used to analyse Pavement data and make recommendations for the 
Forward Work Programme. RAMM provides a method of extracting Treatment 
Length and other data from your network in a format that can be imported into 
dTIMS. 

Once you have completed your dTIMS Analyses you can extract the results of one 
or more of them to be returned to RAMM as an Alternative Scenario. 

These dTIMS recommendations are available in RAMM for reference and can be 
compared against the Current or other Programmes. dTIMS Treatment 
definitions are not the same as those used by RAMM. Therefore, RAMM will not 
allow you to alter the format of a scenario created from a dTIMS analysis into the 
Current Programme. 

dTIMS and RAMM have no formal links. They do not share the same database, so 
please be aware that if you make changes in one system they are not directly 
reflected in the other. 

Therefore, if you wish to take the results of your dTIMS analysis and return them 
into RAMM to compare them with your Forward Work Programme, you must not 
make any changes to the Treatment Lengths in RAMM.  

Similarly, it is possible to make adjustments to Treatment Lengths in dTIMS. 
However, you must not do so if you wish to return the results of the analysis back 
to RAMM. 

NOTE: If there are any differences between the Treatment Lengths in RAMM 
and those coming back from dTIMS the results of the analysis will not 
be loaded into RAMM. 

Three types of dTIMS Unload are available in RAMM: dTIMS, dTIMS CT, and 
dTIMS CT Express. 
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dTIMS / dTIMS CT / dTIMS CT Express Unload 
In the RAMM main window, select the type of unload you wish to perform. All 
three unload selections are available from the dTIMS menu. 

The selected dTIMS unload will launch the relevant process and unload the 
required data. 

 

The Path window shows the location of the unload file. You can change this 
location if necessary by typing it in or clicking the Browse button  to choose 
another location. 

Click the Unload All button next to the Path window and select the file type for your 
unload files. RAMM will create the unload files at the selected location. 
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dTIMS Load 
Information from the dTIMS Analysis can be loaded into RAMM using the Projects 
> dTIMS > Load menu in RAMM Manager. 

 

The information that RAMM will accept can be extracted from dTIMS using the 
Reporter Program. Place the files created from dTIMS into a directory on your 
Hard Drive. Type or use the Browse function to enter the path to these files. 

You should have the following files from dTIMS: 

§ dtims_header.unl 

§ dtims_tl.unl 

§ dtims_treatment.unl 

§ dtims_fwp.unl 

Click on the Next button to load the selected information.  

You will be given details of the files that you are about to load. If they are the 
correct files then click on the Finish button to load the information. 

If there are no problems then the results of the dTIMS analysis will be loaded. 
However, if the Treatment Lengths do not match then you will not be allowed to 
load the analysis. 
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National Tables Export 
Data which is recorded in tables that are nationally maintained, by Transit New 
Zealand can be unloaded from the master database in RAMM Manager using the 
Projects > Forward Work > National Tables > Export menu. 

 

This option is only available to you if you are working with the Transit New 
Zealand database. 

Much of the national data differs for each of the Network Management Areas in 
your database. Therefore, you need to select the NMA that you wish to extract 
national data for and save that to its own file. Create, and send to your 
Consultants, one file for each NMA. 

The nationally controlled data that will be extracted is as follows: 

§ Maintenance Intervention Strategies. 

§ Safety Intervention Strategies. 

§ Treatments. 

§ Treatment Groups. 

§ Funding Groups. 

§ Reasons. 

§ Primary Motivators. 

§ Reason / Primary Motivator Relationships. 

§ MARG Factors. 

§ MARG Weightings. 

§ MARG Default Activities. 

§ Note Types. 
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Running the process will display a list as follows: 

 

This is a list of all the nationally controlled tables that have had data extracted and 
stored in the file that you nominated. You can now send this file to your 
Consultant to be loaded into their database. 
 

National Tables Import 
If you wish to load the latest version of the nationally controlled data then you can 
do so in RAMM Manager from the Projects > Forward Work > National Tables > Import 
menu.  
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You can only import the data for one Network Management Area at one time. If 
you have two or more NMAs in your database then you should have received one 
file for each of them. 

Clicking on the Import button displays the following: 

 

Once this is complete, your National tables will be up to date. 
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Maintenance treatments drawn from Year 2 of the Forward Work Programme into 
the Annual Plan may require further detailed consideration before commitment. 

Chapter 1 – Section 10 of the SHAMM discusses Project Ranking in terms of Pre-
commitment Verification, Project Ranking Methodologies, and Specific 
Methodologies. 

Ranking methodologies are currently available for Area Wide Pavement Treatment 
and Resurfacing. 

IN  THIS  CHAPTER 
Maintenance Allocation Review Group Calculations ..............169 

 
 

Maintenance Allocation Review Group Calculations 
The methodologies used in the Maintenance Allocation Review Group (MARG) 
calculations are the Pavement Area Treatment Index (PATI) and the Resealing Index 
(RI). 

Detailed discussions of these methodologies can be found in the SHAMM manual. 
See Chapter 1 – Appendix G for a discussion of PATI calculations and Chapter 1 – 
Appendix H for the RI calculations. 
 

When Do You Need To Calculate MARG? 
In the Forward Work Programme process, MARG Weighting is only used after the 
following activities are completed: 

§ Treatment Lengths altered, validated and problems corrected. 

§ Exceptions run to highlight problem areas. 

§ Treatment selection run to recommend treatments and report missing data. 

Project Ranking 
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§ Forward work programme decided for each Treatment Length. 

§ Optionally, the programme unloaded by consultants, loaded by Transit New 
Zealand Head Office and collated into a larger Network view. 

It is assumed at this point in the process, that any data problems underlying the 
Forward Work Programme or Treatment Lengths will have been reported in 
previous activities and have been rectified as far as possible. There is no 
requirement to report problems such as data being unavailable, or business rules 
compromised when calculating the MARG Weighting for a treatment. If problems 
are encountered that prevent the MARG Weighting being calculated, it is set to 
zero and you are warned of the Treatment Length and treatment that failed. 

The process to recalculate MARG Priorities is run by you whenever required. 
MARG priorities are not recalculated as part of the Treatment Length Summarise process.  

The calculation is always performed on current available data.  
 

Overriding the Calculated MARG Values 
Transit New Zealand has the ability to override the calculated MARG values. Both 
the calculated and override figures are kept in the system. 

When re-running the MARG calculation at Transit New Zealand you can choose 
to clear the override values if you wish. 

Consultants do not have the ability to either enter override values or clear any that 
may be present in the database. 

An additional priority indicator is available that is independent of the calculated or 
override MARG values. This priority, which is of the form of a High / Medium / 
Low flag can be set against a Treatment Length at any time. 
 

Who can use MARG? 
You can have three levels of access to the MARG facilities: 

§ View: View MARG Weighting calculated for a treatment.  

§ Run: You are permitted to clear MARG priorities and re-run the calculations. 

§ Override: You can override the system calculated MARG Weighting (Transit 
New Zealand only). 
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Assigning MARG Indices to Treatments 
The definition of which Treatments are associated with the Reseal Pavement Area 
Treatment Index is achieved through the Treatment Group Definition. 

 

Each Treatment Group can be assigned to either the Reseal Index or PATI. 
Therefore, all Treatments that are members of that Group are then included in the 
calculation. 

Other treatments that currently do not have a MARG score calculated for them can 
be added to the appropriate Treatment Group (Pavement or Surfacing (Reseal)) in 
the Treatment Group drop-down menu of the Treatments window. 
 

MARG Factors and Weightings 
All the weightings, the parameters for the weightings and the adjustment factors 
are maintainable by you. However, the database administrator should be the only 
person to change these weightings. This is to ensure national uniformity when it 
comes to ranking projects for funding allocation. 
 

Maintaining MARG Factors 
Access to the MARG Factors maintenance window is through RAMM Manager 
using the menu Projects > Forward Work > MARG > Factor. 
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The MARG Index Factors have been defined by Transit New Zealand and 
preloaded into the database. It is not possible for either Transit New Zealand or 
Consultants to add or remove these Factors. 

However, the value of the Weight, given to the Factor, can be modified at any time 
by either Transit New Zealand or Consultants. 

Consultants should note, however, that this information is not recorded by 
Network Management Area and is not returned to Transit New Zealand. 
Therefore, any changes that you make in this area will be lost and replaced by the 
Transit New Zealand definitions the next time you receive a new copy of the 
NMA database. 
 

Maintaining MARG Weightings 
Access to the MARG Factors maintenance window is through RAMM Manager 
using the menu Projects > Forward Work > MARG > Weighting. 

 

Once again the MARG Weighting Types have been defined by Transit New 
Zealand and pre-loaded into the database. It is not possible for either Transit New 
Zealand or Consultants to add or remove Weighting Types. However, the 
Weightings that go to make up the Types can be added to, deleted, or modified. 
This is available to either Transit New Zealand or Consultants. 

Consultants should note, however, that this information is not recorded by 
Network Management Area and is not returned to Transit New Zealand. 
Therefore, any changes that you make in this area will be lost and replaced by the 
Transit New Zealand definitions the next time you receive a new copy of the 
NMA database. 
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Calculating A MARG Score 
Check that there is a value in the Upper Pavement Layer Moisture Sensitivity box 
on the Pavement tab in the Treatment Length detail view. A MARG value cannot 
be calculated without this.  

The default value is "Not A Problem", but the Consultant should select their own 
value for this field. To add or change a value, click the Maintain button on the 
Treatment Length table in RAMM. All other fields should be populated because 
most of the data is taken from the Treatment Length summary table, which is 
updated when Treatment Length Resummarise is run. 

Click Calculate on the Year 2 MARG Weightings tab of the Treatment Length detail 
view or of the Forward Works Programme window in RAMM, or in RAMM 
Manager from the menu Processes > Treatment Lengths > MARG Calculation. 

Select either the current Treatment Length or all Treatment Lengths (this may 
take some time for a network), and decide whether you want to erase user-entered 
(override) values and priorities (these options are only available to Transit New 
Zealand users). 

Click Calculate.  

After calculation has finished, push F5 to refresh the window and view the 
calculated MARG values. 

It is also possible to calculate the MARG score for all or an individual Treatment 
Length by accessing the Year 2 MARG Weightings tab on either the Treatment 
Length Detail window or the Forward Work Planning window. 
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User Override And Priorities 
If Transit New Zealand thinks that the calculated score is not right, then a score 
that is more representative of the Treatment Length can be entered. A priority can 
also be attached if this is appropriate. 

These user-entered values can only be entered and changed by Transit New 
Zealand, and cannot be erased by the Consultant. They are not erased when 
MARG is recalculated unless specified, and in the reporting the override value is 
used for ranking, not the calculated value. 

To enter values, simply click on the box next to the calculated MARG score and 
type the number or select from the pull down menu for the priority. 

You can access the MARG data for a Treatment Length from the Year 2 MARG 
Weightings tab on the Treatment Length Detail window. 

 

Alternatively, you can also get at the same information from the Year 2 MARG 
Weightings tab on the Forward Work Planning window. 
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Reporting MARG Scores 
There are two reports available in RAMM Manager: 

§ Detailing calculation errors in the MARG process (when the word "Failed" 
appears in the MARG value box, or the value is zero).  

§ Lists those Treatment Lengths with a MARG value, from highest score 
(highest priority) to lowest score (lowest priority) by programme, region, 
network management area and treatment group.  

These are accessed from Reports > Forward Work > MARG Calculation Error and Reports > 
Forward Work > MARG Treatment Detail. 
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The following is a checklist of database housekeeping functions to be carried out 
periodically. It must not be regarded as complete, rather consider it a dynamic list 
that will be added to based on operational experience, user feedback and requests 
for assistance. 

IN  THIS  CHAPTER 
Tables ........................................................................................177 
Functions...................................................................................177 

 
 

Tables 
Cost sets - the treatment cost sets should be reviewed at least annually checking: 

§ The appropriateness of the split of cost sets. Do they still fairly represent the 
areas where costs change? 

§ The costs allocated to each treatment within the cost set. 
 

Functions 
Summarise - This process is described within the software documentation. It 
summarises the data held against Treatment Lengths, and checks the integrity of 
the consistency of the Treatment Lengths (are they contiguous, covering the full 
length of roadnames, etc). 

 

Database Housekeeping 
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IN  THIS  CHAPTER 
Forward Work Planning Environments....................................179 
Staff Permissions .......................................................................180 

 
 

Forward Work Planning Environments 
There are three Forward Work Planning environments, and it's important to 
understand distinctions between them before setting the User Type in Staff 
Permissions (on page 180). 

Road Controlling Authority Environment 
Transit New Zealand, as the Road Controlling Authority (RCA), retains the master 
database of the road network, and would work with the Forward Work Programme 
in the Road Controlling Authority environment. A working view of the master 
RAMM database for one or more Network Management Areas is given to each 
Consultant. 

Consultant Environment 
The Consultant then works with the Forward Work Programme for those 
Network  Management Areas. The Consultant has access to only the working view 
of the database instead of all the roads. Therefore, the Consultant environment and 
tools are different to those of the RCA to ensure that the Forward Work 
Programme is not edited in ways that will cause conflicts and errors. 

Local Authority Environment 
The Local Authority environment allows unrestricted access to all functionality. 
This environment is used when there is no need to allow for the division of the 
road network into smaller Network Management Areas and a diversity of roles 
within the Forward Work Programme. 
 

Security in Forward Work Planning 
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Staff Permissions 
Staff Permission levels are an effective way to control access to your database, and 
the tasks that can be performed on it. 

They are set in RAMM Manager, in the Staff Permissions window. A full 
discussion of Staff Security is available in the Security section of the Working with 
RAMM guide. 

This topic is specific to Staff Permissions in Forward Work Planning. 

4 Setting User Level Permissions 

1 In RAMM Manager, launch the Staff Permissions window by selecting 
Maintenance > Staff. 

2 If this is the first time you're running Staff Permissions, the window will open 
blank, giving you the option of setting them up. Click Add New User if you wish 
to set up a Permission for a single user, or Add the All Users Item to set up 
Permissions affecting all users. 

 

3 The window will now show a Permission in the list on the left, depending on 
your choice. You can add another Permission at any time by clicking and 
selecting it from the Add Item button drop-down list on the toolbar: 
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4 Set the access level for the Permission you just entered. The No Access, View Only 
and Full Control settings are quite straightforward, and do not require any 
adjustment beyond selecting the level. 

 

5 To set custom Permissions like the User Type and specific access to parts of the 
Forward Work Programme, click Custom. The Detail panel will now show  
another tree with the relevant categories. 

Click the Forward Work category in the tree to view and select the required 
options. 

 

6 Save  the Permission when you are done. 
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Each of the Forward Work Permissions available to you is described below. 
 

User Type 
This drop-down list in the Custom Staff Permissions detail panel is to set the User 
Type for the database. For more information, see Forward Work Planning 
Environments (on page 179). 

§ Road Controlling Authority. For the user of the master database- most likely, Transit 
New Zealand. 

§ Consultant. Select this option if you are using a working view of the database to 
manage Network Management Areas. 

§ Local Authority. For unrestricted access to all Forward Work Programme 
functions. 

 

Forward Work Programme 
This is simply a Yes/No switch to indicate if you have permission to use any of the 
Forward Work Programme tools. 
 

National Lookup Tables 
This is another Yes/No switch to indicate if you have permission to Export and 
Import the National Lookup data. This is the data maintained by Transit New 
Zealand. 
 

Regional Lookup Tables 
This Yes/No switch that determines if you have permission to maintain the 
Regional Lookup data. This is the data maintained by the Consultant. 
 

End of Year Rollover 
This is a Yes/No switch to indicate if you have permission to run the End of Year 
Rollover process. This is best left switched off. 
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MARG 
This switch determines what access you have to the MARG information. The 
default is View Only, but this can be changed if necessary. 

§ View Only. This indicates that you can see the MARG information and run the 
Treatment Detail and Error reports, but cannot run the process to calculate 
MARG or set override values. 

§ Calculate. This indicates that you can, in addition to viewing the MARG values, 
run the process that calculates the MARG. If you have this level of permission 
you cannot edit the Override values. 

§ Override and Calculate. This indicates that you have full access to the MARG data. 
You can run the MARG calculation process and set override values and 
priorities. 
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Asset Type 
An asset type is a category of the assets that make up your network - like Bridges or 
Footpaths. 
 

Database 
A computerised container for large amounts of information - in RAMM’s case, 
about a particular roading network. You may use more than one RAMM database, 
particularly if you work with more than one Road Controlling Authority. 
 

Detail Window 
Type of window used for working with road asset details one at a time, particularly 
when you're editing and viewing them. 
 

Filter (Database Filter, Grid Filter) 
Filters enable you to streamline the information you see in the Road Selection 
panel and Detail or Grid windows (see below) by sorting the data according to 
various criteria. 
 

Grid Window 
Type of window used for working with road assets, usually for more than one road 
at a time. A Grid window is basically a visual report writer - you get everything 
looking the way you want by adjusting the Grid layout, then work with road assets, 
export or print the displayed details. 
 

Hosting 
The RAMM Hosting service lets you run RAMM across the Internet.  
 

LTNZ 
Land Transport New Zealand, formerly known as Transfund New Zealand. 
 

MARG 
Maintenance Allocation Review Group. 
 

Glossary 
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MIS 
Maintenance Intervention Strategy. These definitions are maintained nationally by 
Transit New Zealand. 
 

Network 
The network is the entire collection of roads managed by a particular Road 
Controlling Authority. Each RAMM database usually contains all the information 
for a particular network. 
 

NMA 
Network Management Area- the section of the road network that a Consultant is 
responsible for. NMAs are associated with MIS codes. 
 

NOMAD 
National Optimisation of Maintenance Allocation by Decade, the software 
component providing pavement maintenance and treatment information at a 
project level for up to 20 years on behalf of Transit New Zealand. NOMAD, also 
known as RAMM Forward Work Planning, is interlinked with dTIMS / dTIMS 
CT, the decision tool for future works, and the Annual Plan process. 
 

Null 
Blank, having no value. 
 

RAMM 
Road Assessment and Maintenance Management - the full name of the software 
that this guide describes. 
 

RCA 
Road Controlling Authority. The organisation responsible for managing a 
particular network of roading assets. 
 

Record 
A record holds all the details about a particular item, like a Berm or Street Light. 
Think of it like your medical record that holds all the details about your health, or 
your school record that holds academic details. 
 

RMCE 
Routine Maintenance Cost Estimation. RMCE curves provide the basis of cost 
estimation for Maintenance Intervention Strategies. 
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Road Asset 
A detail about a particular aspect of the roads - their Pavement layers or Condition, 
for example. 
 

SHAMM 
State Highway Asset Management Manual. Also known by its code SM020. 
 

SIS 
Safety Intervention Strategy. 
 

Table 
Container in the RAMM database that holds all the records about an aspect of all 
the roads - their Berm or Shoulder details, for example. Each table holds all the 
information about only one aspect of all the roads. 
 

TFNZ 
Transfund New Zealand. See LTNZ above. 
 

TNZ 
Transit New Zealand. 
 

TSA 
Treatment Selection Algorithm. The formula used to calculate optimal forward 
work. 
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